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Notes, Cautions and Warnings

  

   

     

NOTE

A note provides additional information to supplement the 
main text which may help you to use and understand the 
product.

CAUTION!

A caution provides additional information which, if 
ignored, may result in equipment malfunction or 
damage.

WARNING!
A warning provides additional information which, if 
ignored, may result in a risk of personal injury.



Introduction

Congratulations on buying this Oki color printer. Your new 
printer is designed with advanced features to give you clear, 
vibrant color prints and crisp black and white pages at high 
speed on a range of office print media.

Your printer includes these features:

> Multi-level technology produces subtle tones and smooth 
gradations of color to lend photographic quality to your 
documents.

> Prints up to 16 ppm (pages per minute) in full color for fast 
printing of high impact color presentations and other documents.

> Prints up to 20 ppm (pages per minute) in black and white for 
fast and efficient printing of all general purpose documents not 
requiring color.

> 600 x 600 dpi (dots per inch), 1200 x 600 dpi and 600 x 600 dpi 
x 2-bit print resolution for high quality image production showing 
the finest detail.

> Single Pass Color Digital LED technology for high speed 
processing of your printed pages.

> 10Base-T and 100Base-TX network connection lets you share this 
valuable resource among users on your office network.

> High speed USB 2.0 interface 

> Postscript 3, PCL 5C, PCL 6 and Epson FX emulations for industry 
standard operation and wide compatibility with most computer 
software

> Photo Enhance mode to improve printouts of photographic 
images (Windows PCL driver only)

Additionally, the following optional feature is available:

> Additional memory, to allow printing of more complex pages.
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Printer overview

Front view

      printer parts_Fig1_03.jpg  

       

1. Printer cover and Output stacker, 
face down. 
Standard printed copy delivery 
point. Holds up to 150 sheets at 
20 lb. (80 g/m²).

2. Operation Panel. 
Status LEDs and operator 
buttons.

3. Cassette Tray. 
Standard blank paper tray. Holds 
up to 250 sheets of 20 lb.  
(80 g/m²) paper.

4. Multi Purpose Feeder Tray Release 
(when closed, press to open). 
Multi Purpose Tray: 
Used for manual duplex, feeding 
heavier paper stocks, envelopes 
and other special media. Also for 
manual feeding of single sheets 
when required.

5. ON/OFF switch.

6. Front Cover Open Release (press 
to open).

7. Printer Cover Open Release (push 
to open).

1

4

2

3

6

6
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Rear view

This view shows the connection panel and the rear output 
stacker.

        Ports rear position_F12_3 v11.jpg  

   

When the rear paper stacker is folded down, paper exits 
through the rear of the printer and is stacked face up. The rear 
stacker is mainly used for heavy print media. When used in 
conjunction with the Multi Purpose Tray, the paper path 
through the printer is essentially straight. This avoids bending 
the paper around curves in the paper path inside the printer 
and enables feeding of up to 54 lb. (203 g/m²) media.

1. AC Power Socket.

2. USB interface   
USB cable must be of length 2 m 
maximum for reliable Status 
Monitor operation.

3. LAN Port

4. Network Test Button

5. Rear Stacker, face up.  
Can hold up to 10 sheets of 20 lb. 
(80 g/m²) standard paper and 
can handle paper stocks of up to 
54 lb. (203 g/m²). 

5

1

3
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4
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Inside your printer

Press the Cover Open Release to open the printer cover and 
look inside the printer.

    Inside printer_Fig1_04.eps.jpg 

        

1. Fuser unit. 
The Fuser unit contains a heated 
roller that fixes toner to the print 
media (paper or card).

2. Fuser lever. 
The lever has a locked position for 
when the toner cartridge is in 
place and an unlocked position for 
removal and changing.

3. Toner cartridges and toner 
cartridge levers. 
The 4 toner cartridges hold dry 
powdered ink. The lever locks the 
toner cartridge into place on the 
image drum or releases it for 
changing. 

Image drum units (under toner 
cartridges).  
The toner from the toner 
cartridges adheres to the outer 
plate of the image drum. The 
image drum then transfers the 
toner to the print media as it 
passes through the printer.

4. LED Heads. 
4 LED (Light Emitting Diode) 
Heads direct light onto the 4 
image drums.

1

2

4

2

3

C3600n User’s Guide
9



The Operation Panel
The Operation Panel allows operator intervention and indicates 
both when the printer is operating normally and when it 
requires attention. Detailed printer status is provided by the 
Status Monitor in Windows or Printer Driver in Mac. (See 
“Using the Status Monitor” on page 55.) 

      op panel_F8_03.jpg  

The Operation Panel incorporates 2 LEDs, a two-line LCD, and 
6 push-buttons as follows (from left to right):

1. ATTENTION LED (amber)

2. ON LINE LED (green)

3. LCD

4. Menu Back button

5. Menu Up button

6. Menu Down button

7. Menu Enter button

8. ON LINE button

9. CANCEL button

The buttons are used to operate the printer; the LEDs and LCD 
display the status of the printer.
C3600n User’s Guide
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Buttons

Operation

There are four Menu buttons on the operation panel (Back, Up, Down, 
and Enter) and two buttons labeled ON LINE and CANCEL. They 
operate as follows:
       
BUTTON FUNCTION

Back Press to return to the previous higher level menu 
item. Also exits the menu system (press it until 
CMYK is displayed).

Menu Up and 
Down

Press either to enter Menu mode. 

In Menu mode use the Up and Down arrow keys to 
move forwards and backwards through the lists of 
menus and menu items.

Hold down for at least 2 seconds to fast forward or 
reverse.

Enter Press to enter Menu mode.

In Menu mode: press to select the option displayed 
on the LCD.

On Line Press to switch between Online and Offline modes.

In Menu mode: exits the menus and puts the printer 
ONLINE.

When WRONG PAPER or WRONG PAPER SIZE is 
displayed on the LCD, press the switch to force 
printing on the paper currently loaded.

Cancel Deletes the data being printed or received when 
pressed for at least two seconds.

Deletes the data when pressed for at least two 
seconds when one of the following error messages is 
displayed: WRONG PAPER SIZE, RUN OUT OF PAPER, 
TRAY 1 IS OPEN, or TRAY 1 IS NOT FOUND.

In Menu mode: press to exit the menu and put the 
printer ONLINE.
C3600n User’s Guide
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LCD Display

The 2-line, 16-character LCD display shows the printer status, 
menus, and any error messages. 

When the printer is in a “ready” state, toner gauges are 
displayed on the LCD. The top line identifies the toner colors: 
C M Y K; the bottom line shows four “level” gauges. The level 
gauges represent how much toner remains for each of the 
colors. The toner gauges are not displayed when the printer is 
printing or in an error mode.

Remaining toner levels are as follows:

100-60%:

50-40%:

30-10%:

“Toner Low” indication:

Changing the LCD Display Language

The Operator Panel Language Setup utility changes the 
language on the printer’s LCD display panel. The utility is on 
the CD-ROM that comes with your printer. For more 
information about the utilities, see “Overview” on page 114. 

Follow the steps in the setup utility to select the 3600n printer 
and the desired language. To complete the language setup, re-
start your printer (i.e., turn it off and then on).
C3600n User’s Guide
12



LED Displays

General

Printer status (as indicated by the LEDs) can be broadly 
categorized as follows:

1. Normal status (Green): the printer is operating normally e.g. it is 
ON LINE or processing.

2. Warning status (Amber): you can continue to use the printer 
without intervention but an error may result.

3. Error status (Amber, blinking): you cannot continue to use the 
printer. Intervention is required to recover from the error. Fatal 
errors are irrecoverable and require a service call.

Function

A summary of the functions of each LED is given below:

    

The Status Monitor in Windows provides a readable description 
of the printer status corresponding to the error indications on 
the LCD. In Mac, the printer driver provides status information 
once you have sent a document to print. In Windows, if you 
have the Status Monitor Preferences set to Pop up on alerts, 
this readable message will be presented on screen whenever 
an abnormal condition occurs. See “Using the printer software” 
on page 55 for more information.

Service call error

When a service call error occurs, both LEDs blink rapidly and 
simultaneously and an error number is displayed on the LCD.

LED COLOR FUNCTION

ATTENTION Amber ON: Attention state (e.g., tray open or 
paper out)

BLINKING: Warning state (e.g., cover 
open)

OFF: Normal condition
ON LINE Green ON: Ready to receive data

BLINKING: Processing data

OFF: Offline
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Paper recommendations

Your printer will handle a variety of print media, including a range of 
paper weights and sizes, including envelopes. This section provides 
general advice on choice of media, and explains how to use each type.

The best performance will be obtained when using standard 20–24 lb. 
(75–90 g/m²) paper designed for use in copiers and laser printers. 
Suitable types are:

• Hammermill® Laser Printer Radiant White, 24 lb. US 
Bond (90 g/m²)

• Xerox® 4024, 20 lb. US Bond (75 g/m²)

• Oki® 52206101 Bright White Proofing Paper, 32 lb. US 
Bond (120 g/m2)

Use of heavily embossed or very rough textured paper is not 
recommended.

Pre-printed stationery can be used, but the ink must not offset 
when exposed to the high fuser temperatures used in the 
printing process.

Envelopes should be free from twist, curl or other 
deformations. They should also be of the rectangular flap type, 
with glue that remains intact when subjected to hot roll 
pressure fusing used in this type of printer. Window envelopes 
are not suitable.

Labels should also be of the type recommended for use in 
copiers and laser printers, in which the base carrier page is 
entirely covered by labels. Other types of label stock may 
damage the printer due to the labels peeling off during the 
printing process. Suitable types are:

• Avery 5161 White Laser Label (Letter size)

• Avery 7162, 7664, 7666 White Laser Labels (size A4).
C3600n User’s Guide
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Cassette Tray
The Cassette Tray can handle paper in weights of 17 to 47 lb. 
(64 g/m² to 176 g/m²). The Cassette Tray is ideal for printing 
Letter size documents of more than 1 page in length. 

   
TRAY WEIGHT SIZE DIMENSIONS

Cassette 

Tray

Light:

   17-20 lb. 

   64-74 g/m²

Medium: 

   20-24 lb.

   75-90 g/m²

Heavy:

   24-47 lb. 

   91-176 g/m²

A6 4.13 x 5.83 in.

105 x 148 mm
A5 5.83 x 8.27 in.

148 x 210 mm
B5 7.17 x 10.12 in.

182 x 257 mm
Executive 7.25 x 10.5 in.

184.2 x 266.7 mm
A4 8.27 x 11.69 in.

210 x 297 mm
Letter 8.5 x 11 in.

215.9 x 279.4 mm
Legal 13 in. 8.5 x 13 in. 

216 x 330 mm
Legal 13.5 in. 8.5 x 13.5 in.

216 x 343 mm
Legal 14 in. 8.5 x 14 in. 

216 x 356 mm
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Multi Purpose Tray
The Multi Purpose Tray can handle the same sizes as the 
Cassette Tray but in weights up to 54 lb. (203 g/m²). For very 
heavy paper stock, always use the face up (rear) paper 
stacker. This ensures that the paper path through the printer 
is almost straight.

The Multi Purpose Tray can feed paper widths as small as 
3.94 in (100 mm) and lengths up to 47.24 in. (1200 mm) 
[banner printing]. 

For paper lengths exceeding Legal 14 in. (356 mm) use paper 
stock between 24 and 34 lb. (90 g/m² and 128 g/m²) and the 
face up (rear) paper stacker.

When using the Multi Purpose Tray, each sheet of paper can 
only be fed one at a time.

Watermarked or Headed paper should be loaded print side up 
and top edge into the printer.
C3600n User’s Guide
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TRAY WEIGHT SIZE DIMENSIONS

Multi

Purpose 

Tray

Light:

   17-20 lb. 

   64-74 g/m²

Medium: 

   20-24 lb.

   75-90 g/m²

Heavy:

   24-32 lb.

   91-120 g/m²

Ultra heavy:

   32-54 lb.

   121-203 g/m²

A6 4.13 x 5.83 in.

105 x 148 mm
A5 5.83 x 8.27 in.

148 x 210 mm
B5 7.17 x 10.12 in.

182 x 257 mm
Executive 7.25 x 10.5 in.

184.2 x 266.7 mm
A4 8.27 x 11.69 in.

210 x 297 mm
Letter 8.5 x 11 in.

215.9 x 279.4 mm
Legal 13 in. 8.5 x 13 in.

216 x 330 mm
Legal 13.5 in. 8.5 x 13.5 in.

216 x 343 mm
Legal 14 in. 8.5 x 14 in.

216 x 356 mm
Custom sizes 8.5 x 47.24 in.

216 x 1199.9 mm
Letterhead 8.5 x 10.98 in.

216 x 279 mm
COM-9 
Envelope

3.87 x 8.87 in. 

98.4 x 225.4 mm
COM-10 
Envelope

4.12 x 9.5 in. 

104.7 x 241.3 mm
Monarch 
Envelope

3.87 x 7.5 in. 

98.4 x 190.5 mm
C5 6.38 x 9.02 in.

162 x 229 mm

DL
4.3 x 8.6 in.

110 x 220 mm

Banner
8.27 x 48 in.

210 x 1220 mm 
(maximum)
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Face Down Stacker
The Face Down Stacker on the top of the printer can hold up 
to 150 sheets of 20 lb. (80 g/m²) standard paper, and can 
handle paper stocks up to 32 lb. (120 g/m²). Pages printed in 
reading order (page 1 first) will be sorted in reading order (last 
page on top, facing down).

Face Up Stacker 
The Face Up Stacker at the rear of the printer should be 
opened and the paper support extended when required for 
use. In this condition paper will exit via this path, regardless of 
driver settings.

The Face Up Stacker can hold up to 1 sheet of 20 lb.  
(80 g/m²) standard paper and can handle stocks up to 54 lb. 
(203 g/m²).

Always use the Face Up Stacker and the Multi Purpose Tray for 
paper stocks heavier than 47 lb. (176 g/m²).
C3600n User’s Guide
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Loading Paper

Cassette Tray
1. Remove the Cassette Tray from the printer.

     cassette tray empty_Fig1_16.jpg   

2. Fan the paper to be loaded at the edges (1) and in the middle (2) 
to ensure that all sheets are properly separated, then tap the 
edges of the stack on a flat surface to make it flush again.(3).

   Fan Paper.jpg   
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3. Adjust the Rear Stopper (1) and Paper Guides (2) to the size of 
paper being used. Use the markings on the printer as a guide (3).

       Cassette Tray paper guides_F7_01.jpg   

4. Load the paper (1). Use the level indicators (2) as a guide. For 
letter headed paper, load face down with top edge towards the 
front of the printer.

      paper load_Fig1_17 v11.jpg   

To prevent paper jams:

• Do not leave space between the paper and the guides and 
rear stopper.

• Do not overfill the Cassette Tray. Capacity depends on the 
type of paper stock.

• Do not load damaged paper.

• Do not load paper of different sizes or types at the same time.

• Do not pull the Cassette Tray out during printing.

2

3

1
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5. Close the Cassette Tray gently.
     Cassette Tray wPaper_close_Fig1_22.jpg   

• For face down printing, make sure the Face Up (rear) (4) 
Stacker is closed (the paper exits from the top of the printer). 
Stacking capacity is approximately 250 sheets, depending on 
paper weight.

• For face up printing, make sure the Face Up (rear) (4) Stacker 
is open and the paper support (5) is extended. Paper is 
stacked in reverse order and tray capacity is approximately 10 
Letter/A4 sheets, depending on paper weight, or 1 envelope 
or 1 sheet of heavier media.

• Always use the Face Up (rear) Stacker for heavy paper (card 
stock etc.).        rear stacker open_F7_10.jpg  

  

CAUTION!

Do not open or close the rear paper exit while printing as it 
may result in a paper jam.

4

5
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Multi Purpose Tray
1. Open the Multi Purpose Tray and press gently down on the Paper 

Platform (1).

     mpt tray_F7_05.jpg   

2. Adjust the Paper Guides (2) to the size of paper you are going to 
print on, using the markings on the Paper Platform.

3. Position a sheet of paper on the Paper Platform so that it is 
gripped in place.

• Load your chosen media one sheet at a time.

• When printing on headed paper load the paper into the Multi 
Purpose Tray with pre-printed side up and top edge into the 
printer.

• An envelope should be loaded face up with top edge to the left 
and short edge facing into the printer.

Set the correct paper size for the Multi Purpose Tray in the 
Media Menu. (See “Printer functions (User Settings)” on 
page 56.)

1

2

2
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Printing from Windows

Your printer’s menus provide access to many options. See 
“Using the printer software” on page 55 for more information.

The Windows printer driver also contains settings for many of 
these items. Where items in the printer driver are the same as 
those in the menus, and you print documents from Windows, 
the settings in the Windows printer driver will override those 
items in the menus.

The illustrations in this chapter show the printer in 
Windows XP/2000. Other Windows versions may appear 
slightly different, but the principles are the same.

Printer driver settings
A printer driver is a software program that controls a printer. 
The printer driver feeds data about printing requirements for a 
document to the printer.

You can make printer driver settings either from Windows 
Printers window (called “Printers and Faxes” in Windows XP) 
or from within a Windows application. The driver settings you 
make from the Windows “Printing Preferences” dialog box are 
essentially default settings and will be remembered from one 
Windows session to the next. The driver settings you make 
from within a Windows application, e.g. in the File -> Print 
dialog box in Microsoft Word, are those required for a 
particular job and will not be remembered the next time you 
open this application. In both cases, you can save and name 
(on the Setup tab) specific sets of driver settings which can be 
recalled for future use.
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Printing preferences in Windows applications
When you choose to print your document from a Windows 
application program a Print dialog box appears. This dialog 
usually specifies the name of the printer on which you will print 
your document. Next to the printer name is a Properties 
button.

When you click Properties a new window opens which 
contains a short list of the printer settings available in the 
driver, which you can choose for this document. The settings 
available from within your application are only those which you 
may want to change for specific applications or documents. 
Settings you change here will usually only last for as long as 
the particular application program is running.

Setup tab

When you click the Properties button from your application’s 
Print dialog, the driver window opens to allow you to specify 
your printing preferences for the current document.  

1. Size

Paper size should be the same as the page size of your 
document (unless you wish to scale the printout to fit 
another size), and should also be the same as the size of 
paper you will feed into the printer.

2. Source

You can choose the source of the paper to feed, which 
may be Tray 1 (the Cassette Tray) or the Multi Purpose 
Tray. You can either select the tray from the dropdown list 
or you can click on the appropriate part of the printer 
graphic to select your preferred tray.

3. Weight

The setting for paper weight should match the type of 
paper on which you intend to print. 

4. Paper Feed Options

Click on the Paper Feed Options button to modify your 
document to fit to paper of a different size and to access 
advanced Cassette Tray and Multi Purpose tray settings.
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5. Finishing Mode

A variety of document finishing options can be selected, 
such as normal one page per sheet, or N-up (where N can 
be a maximum of 16) for printing scaled down pages at 
more than one page per sheet.

Select the Poster printing option to print large pages as tiles 
spread over multiple sheets.

6. 2-Sided Printing

You can choose to print on one side of a sheet only or to 
use 2-sided printing (duplex printing). Your printer allows 
you to carry out manual duplex printing, meaning you 
must pass the paper through the printer twice. For more 
information, see “2-sided printing (Windows only)” on 
page 42. The Duplex Help button also offers guidelines 
on how to carry out manual duplex printing.

7. Driver Settings

If you have changed some printing preferences before 
and saved them as a set under a specific name, you can 
recall them under driver settings. Saving driver settings 
means that you can avoid having to set printing 
preferences individually each time you need them.

8. Default

Click the Default button to restore the default printer 
settings.

Job Options tab  

1. Print Resolution

The output resolution of the printed page can be set as 
follows.

• The High Quality setting prints at 600 x 600dpi multi-level. 
This setting requires the most printer memory and takes the 
longest to print. It is the best option for printing photographs 
and reproducing color details.

• The Fine/Detail setting prints at 1200 x 600dpi is the best 
option for printing vector objects such as graphics and text.

• The Normal setting prints at 600 x 600dpi and is suitable for 
most printing jobs. 
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2. Photo Enhance

Select this option to improve the quality of photographic 
images.

3. Toner Saving

Select to help save your toner.

4. Skip Blank Pages

Select this option to avoid printing out any blank pages 
that are in your document.

5. Copies

You can select up to 999 copies to print consecutively, 
although you will need to top up the Cassette Tray during 
such a long print run.

6. Orientation

Page orientation can be set to either portrait (tall) or 
landscape (wide).

7. Scale

Your printed pages can be scaled to fit larger or smaller 
stationery.

8. Watermark

You can print watermark text behind the main page 
image. This is useful for marking documents as draft, 
confidential, etc.

9. Advanced

Clicking the Advanced button gives you access to further 
settings. For example, you can elect to have black areas 
printed using 100%K toner (a more matte appearance). 

10. Default

Click the Default button to restore the default printer 
settings.
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Color tab 

1. Color Matching:  Auto or Manual

Control over the color output of your printer may be 
performed automatically, or for advanced control, by 
manual adjustment. The automatic setting will be 
appropriate in most cases. The other options in this 
window only become visible when you select a choice 
other than Auto. For grayscale printing, the printer runs 
at the fastest print speed (approx. 20 ppm) and all pages 
are printed in black and white.

2. Color Mode

You can choose from a range of color matching options, 
depending on the image source for your document. For 
example, a photograph taken on a digital camera might 
require different color matching from a business graphic 
created in a spreadsheet application. Again, for most 
general purpose use, Auto is the best choice.

3. Brightness and Saturation

Printed output may be made lighter or darker, or the 
colors made more saturated and vibrant as required.

4. Black Finish

Black areas may be printed using 100% cyan, magenta 
and yellow, giving a more glossy appearance (composite 
black), or using only black toner (true black), giving a 
more matte appearance. Choosing the Auto setting allows 
the driver to make the most appropriate choice based on 
image content.

5. Default

Click the Default button to restore the default printer 
settings.
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Setting from Windows Control Panel
When you open the driver properties window directly from 
Windows, rather than from within an application program, a 
somewhat more extensive range of settings is provided. 
Changes made here will generally affect all documents you 
print from Windows applications, and will be remembered from 
one Windows session to the next.

General tab  

1. Features

This area lists some of the main features of your printer.

2. Printing Preferences

This button opens the same windows for items which can 
be set from within application programs, as described 
earlier in “Printing preferences in Windows applications” 
on page 24. Changes you make here, however, will 
become the new default settings for all Windows 
applications.

3. Print Test Page

This button prints a test page to check that your printer is 
working.

Advanced tab    

1. Available From

You can specify which times of day your printer will be 
available.

2. Priority

Indicates current priority, from 1 (lowest) to 99 (highest). 
Highest priority documents will print first.

3. Spool print documents so program finishes printing faster

Specifies that documents should be spooled (stored in a 
special print file) before being printed. The document is 
then printed in the background, allowing your application 
program to become available more quickly.
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4. Start printing after last page is spooled

This specifies that printing should not start until the last 
page has been spooled. If your application program needs 
a lot of time for further computation in the middle of 
printing, causing the print job to pause for more than a 
short period, the printer could prematurely assume that 
the document has finished. Selecting this option would 
prevent that situation, but printing will be completed a 
little later, as the start is delayed.

5. Start printing immediately

This is the opposite choice to the one above. Printing 
starts as soon as possible after the document begins 
spooling.

6. Print directly to the printer

This specifies that the document should not be spooled, 
but printed directly. Your application will not normally be 
ready for further use until the print job is complete. This 
requires less disk space on your computer, since there is 
no spool file.

7. Hold mismatched documents

Directs the spooler to check the document setup and 
match it to the printer setup before sending the document 
to print. If a mismatch is detected, the document is held 
in the print queue and does not print until the printer 
setup is changed and the document restarted from the 
print queue. Mismatched documents in the queue will not 
prevent correctly matched documents from printing.

8. Print spooled documents first

Specifies that the spooler should favor documents which 
have completed spooling when deciding which document 
to print next, even if completed documents are lower 
priority than documents which are still spooling. If no 
documents have completed spooling, the spooler will 
favor larger spooling documents over shorter ones. Use 
this option if you want to maximise printer efficiency. 
When this option is disabled the spooler chooses 
documents based only on their priority settings.

9. Keep printed documents

Specifies that the spooler should not delete documents 
after they are completed. This allows documents to be re-
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submitted to the printer from the spooler instead of 
printing again from the application program. If you use 
this option frequently it will require large amounts of disk 
space on your computer.

10. Enable advanced printing features

Specifies whether advanced features, such as page order 
and pages per sheet, are available, depending on your 
printer. For normal printing keep this option enabled. If 
compatibility problems occur you can disable the feature. 
However, these advanced options may then not be 
available, even though the hardware might support them.

11. Printing Defaults

This button provides access to the same setup windows as 
when printing from applications. Changes made via the 
Windows Control Panel become the Windows default 
settings.

12. Separator Page

You can design and specify a separator page that prints 
between documents. This is particularly useful on a 
shared printer to help each user find their own documents 
in the output stack.
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Printing From Mac

Mac OS 9

Choosing Printing Options

Use the print dialog to choose your printer and select options 
for how you want your document to print.

1. Open the document you want to print.

2. If you wish to change the paper size or page orientation, choose 
File > Page Setup.

3. Select File > Print.

4. Select your printer from the Printer pop-up menu.

5. If you wish to change any printer driver settings, select the 
necessary options in the print dialog. You can select more options 
from the Copies & Pages menu. “Changing the default print 
settings”  on page 31 describes how to set printer driver options.

6. Click Print

Changing the default print settings

If you print a document and change the printer driver settings, 
these changes are only remembered for that particular 
document. To change the printer driver settings for all future 
print jobs:

1. Select Apple menu > Chooser.

2. Select your printer driver in the left-hand panel of the Chooser 
window.

3. Select your printer model in the right-hand panel of Chooser.

4. Click Print Preferences.   

5. Change Page Setup Preferences or Print Preferences as required.  
These new settings will be saved as the printer driver defaults.

Page Setup Options - General  

Paper

Choose the paper size that matches your document and the paper 
loaded in the printer. The paper margin is 1/6 inch (4.2 mm) at all 
edges.
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Orientation

Selects either portrait (tall) or landscape (wide).

If using landscape, you can flip the orientation 180 degrees.

Reduce or Enlarge

Documents can be scaled up or down to fit on different paper 
sizes.

Page Setup Options - Layout   

Multiple pages can be shrunk and printed on a single sheet of 
paper. For example, choosing 4-up will tile four of your 
document's pages across a single sheet of paper. 

You can control the order in which the documents are tiled and 
also choose to surround each document page with a border.

Page Setup Options - Custom Paper Size  

You can create and edit custom paper sizes. These appear in 
the paper size menu and can be selected just like any other 
paper size.

Print Options - General    

Copies

Enter the number of copies to print.

If Collate is selected, all the pages of the document print before 
the next copy prints.

Pages

Choose whether to print all the pages of your document or just a 
section of it.

Paper Source

Selects which paper tray to use for your print job.

Quality

Selects the print resolution.

The High Quality setting produces the best graphic images but it 
can take longer to print.

Photo Enhance

Use Photo Enhance to significantly improve quality when printing 
images. The printer driver analyses any photographic images and 
processes them to improve the overall appearance. This setting 
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cannot be used together with the High Quality print quality 
setting.

Toner Saving

Toner saving uses less toner when printing your document. This 
is best suited to draft text documents as it lightens the print 
significantly.

Print Options - Print Control   

If you are using the Windows Print Control Server software to 
manage printers, enter your assigned user name and ID. This 
information is sent along with your print job and is recorded by 
the printer.

Print Options - Color   

Color mode

Color matching 

COLOR MODE DESCRIPTION

Auto Color The driver selects the most 
appropriate color settings.

Advanced Color Allows you to manually adjust color 
and black and white settings or select.

Grayscale Convert all colors to shades of grey.

COLOR DESCRIPTION

Monitor (6500K) 

Perceptual

Optimized for printing photos. Colors 
are printed with emphasis on 
saturation.

Monitor (6500K) Vivid Optimized for printing photos, but 
with even more saturated colors.

Monitor (9300K) Optimized for printing graphics from 
applications such as Microsoft Office. 
Colors are printed with emphasis on 
Lightness.

Digital Camera Results will vary depending on the 
subject and conditions the image 
was taken.
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Black Finish

Controls the way black is printed in color documents.

Composite Black (CMYK): Uses all 4 toner colors to represent 
black. Recommended for color photos.

True Black (K): Uses 100% black toner to represent black. 
Recommended for text and business graphics.

Brightness / Saturation

Increase Brightness for a lighter print. Modify saturation to 
change the strength (or purity) of color.

If the printed colors are too strong, reduce saturation and increase 
brightness. As a general rule, the saturation should be stepped 
down an equal amount to the increased brightness. For example, 
if you reduce saturation by 10, increase brightness by 10 to 
compensate.

Print Options - Layout    

Multiple pages can be shrunk and printed on a single sheet of 
paper. For example, choosing 4-up will tile four of your 
document's pages across a single sheet of paper. 

You can control the order in which the documents are tiled and 
also choose to surround each document page with a border.

Print Options - Options    

Media Weight

Select the thickness/type of paper in the printer. 

It's important to set this correctly as it affects the temperature at 
which the toner is fused to the paper. For example, if you are 
printing on regular paper, don't select Labels as this may cause 
toner smearing and paper jams.

Paper Size Check

Select Paper Size check if you want the printer to warn you when 
the document paper size is different from the paper in the printer.

sRGB The printer reproduces the sRGB 
color space. This might be useful if 
color matching from an sRGB input 
device such as a scanner or digital 
camera.

COLOR DESCRIPTION
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A warning message is displayed and printing continues when you 
load the correct paper and press ONLINE.

When this option is switched off, the printer uses the paper loaded 
in the selected tray regardless of the document size.

Feed Manually from Multi Purpose Tray

Select this if you want the printer to wait until you press the ON 
LINE button when feeding from the Multi Purpose Tray.

This can be useful if printing on envelopes.

Always Create 100% Black (K) Toner 

Select this if you want the printer to always use only black (K) 
toner when printing pure black (RGB = 0,0,0). 

This is effective even when Composite Black (CMYK) is selected in 
the color options.

Run Maintenance Cycle Before Printing

Depending on printing habits and usage patterns, running the 
maintenance cycle before printing may ensure the best possible 
print quality.

This feature uses the printer's image drums and transfer belt; the 
life of these printer parts may be shortened if the maintenance 
cycle is run frequently.

Adjust Character Spacing

Select this if you are having problems with the spacing between 
characters when printing text. For example, spacing is too wide or 
characters appear printed over the top of each other.

This feature can slow down printing, so only use it if you are 
having problems.

Print Options - Watermark 

A watermark is typically faint text that is superimposed on a 
printed document. This can be used to indicate that the 
document is "Draft" or perhaps "Confidential".

You can create watermarks in the printer driver. Select a font 
and modify the watermark size, position, color, brightness and 
angle.

Print Options - Information

Displays a summary of the current printer settings. The driver 
version is also displayed. This may be useful if you want to 
check the Oki website for a newer printer driver.
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Mac OS X
The information in this section is based on Mac OS X 
Tiger (10.4). Other versions such as Panther (10.3) and 
Jaguar (10.2) versions may appear slightly different, but the 
principles are the same.

Setting Printing Options

You can choose your printer and select options for how you 
want your documents to print from the Print dialog box.

To set your printer options:

1. Open the document you want to print.

2. To change the paper size or page orientation, select File > Page 
Setup.    

3. Close the Page Setup dialog box.

4. Select File > Print.

5. Select your printer from the Printer drop-down menu.

6. To change any printer driver settings, select the required options 
from the “Settings” drop-down menu. You can select more 
options from the Copies & Pages menu. For a description of these 
options, see “Print options - Copies & pages”  on page 37.   

7. Click the Print button.

Saving Printing Options

You can save a set of printer driver options to use for future 
documents. 

1. Open the document you want to print.

2. To change the paper size or page orientation, select File > Page 
Setup.   

3. Select Save As Default from the Settings drop-down menu.

4. To save the current printer driver settings as a preset, select 
Save As from the Preset menu. 

5. Enter a name for your preset and click OK.

Changing the default printer and paper size

The following steps describe how to change your default 
printer and the paper size options.

1. Select Apple menu > System Preferences.
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2. Click the Print & Fax icon.

3. Select your printer in the “Selected Printer in Print Dialog” drop-
down menu.

4. Select your required paper size in the “Default Size in Page 
Setup” drop-down menu. 

Page setup options

This section provides a description of the page setup options 
available to you.  

Page Attributes

You can select “Save As Default” to use the current Page Setup 
settings as a standard for all documents.

Format for

Allows you to select your printer model before changing options 
such as Paper size and Orientation.

Paper Size

Select a paper size to match your document and the paper loaded 
in the printer. The paper margin is 1/6 inch (4.2 mm) at all edges. 
To specify your own paper sizes, select “Manage Custom Sizes...”

Scale

You can scale documents up or down to fit onto different paper 
sizes. To fit your document on a specific paper size, select Options 
in the Paper Handling drop-down menu in the Print Options dialog 
box.

Orientation

You can select a portrait or landscape option. When using 
landscape, you can rotate the document 180 degrees.

Print options - Copies & pages  

Copies

This option allows you to enter the number of copies to print. If 
you select Collate, all pages of the document will print before the 
next copy prints.

Pages

You can select whether to print all pages of a document or just a 
section of it.
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Layout    

Pages per sheet

You can shrink multiple pages and print them on a single sheet of 
paper. For example, choosing 4-up will tile four of your 
document's pages across a single sheet of paper. 

You can control the order in which the documents are tiled and 
also choose to surround each document page with a border.

Scheduler  

This option lets you choose whether to print your document 
immediately, or defer printing until later. You can also assign 
a priority to a print job.

These features are useful if you are printing large documents 
that take a long time to print.

Paper handling  

Page order

You can choose to print your document in the normal page order 
(1,2,3..) or reverse order (..3,2,1).

Print

This option allows you to choose whether to print only odd or even 
numbered pages. This is useful if you are using manual duplex for 
which you first print all odd pages, re-insert the paper in the 
printer and then print all even pages.

Destination paper size

Scale documents to fit on the size of paper in your printer. For 
example, you can take a document formatted for Legal/A3 and 
print it on Letter/A4 paper using an Letter/A4 printer.

ColorSync  

Color conversion

For Color Conversion, Standard is the only option available for 
your printer model.

Quartz Filter

Choose a Quartz filter if you wish to apply a special effect to your 
print job, such as Sepia or Blue Tone. This is only available on Mac 
OS X 10.3 (Panther) or later versions.
C3600n User’s Guide
38



Cover page  

Choosing a cover page may help you to identify your printed 
document in a large pile of paper. This is useful in a busy office 
with many people sharing the printer.

Paper source  

This option allows you to select which paper tray to use for 
your print job.

Print quality  

Print quality

Use this option to selects the print resolution. The  setting 
produces the best graphic images, but these images can take 
longer to print.

Photo Enhance

Use Photo Enhance to significantly improve quality when printing 
images. The printer driver analyses any photographic images and 
processes them to improve the overall appearance. This setting 
cannot be used together with the High Quality print quality 
setting.

Toner Saving

Toner saving uses less toner when printing your document. This 
is best suited to draft text documents as it lightens the print 
significantly.

Color  

Color mode    

COLOR MODE DESCRIPTION

Auto Color The driver selects the most 
appropriate color settings.

Advanced Color Allows you to manually adjust color 
and black and white settings or select.

Grayscale Convert all colors to shades of grey.
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Color matching      

Black Finish

Use this option to control the way black is printed in color 
documents. Select Composite Black (CMYK) to use all 4 toner 
colors to represent black. This option is recommended for color 
photos. Select True Black (K) to use 100% black toner to 
represent black. This option is recommended for text and business 
graphics.

Brightness / Saturation

This option allows you to increase brightness for a lighter print. 
Modify saturation to change the strength (or purity) of a color.

If the printed colors are too strong, reduce saturation and increase 
brightness. As a general rule, reduce saturation by the same 
amount as you increase brightness. For example, if you reduce 
saturation by 10, increase brightness by 10 to compensate.

Printer setup options

Printer options    

Media weight

Select the thickness or type of paper in the printer. It is important 
to set this correctly as it affects the temperature at which the 
toner is fused to the paper. For example, if you are printing on 

COLOR DESCRIPTION

Monitor (6500K) 
Perceptual

Optimized for printing photos. Colors are 
printed with emphasis on saturation.

Monitor (6500K) 
Vivid

Optimized for printing photos, but with 
even more saturated colors.

Monitor (9300K) Optimized for printing graphics from 
applications such as Microsoft Office. 
Colors are printed with emphasis on 
Lightness.

Digital Camera Results will vary depending on the 
subject and conditions the image was 
taken.

sRGB The printer reproduces the sRGB color 
space. This might be useful if color 
matching from an sRGB input device 
such as a scanner or digital camera.
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normal Letter/A4 paper, do not select Labels as this may cause 
toner smearing and paper jams.

Paper size check

Select Paper Size check if you want the printer to warn you when 
the document paper size is different from the paper in the printer.

A warning message is displayed and printing continues when you 
load the correct paper in the tray and press ON LINE. When this 
option is deselected, the printer uses the paper loaded in the 
selected tray regardless of the document size.

Feed manually from Multi Purpose Tray

Select this option if you want the printer to wait until you press 
the ON LINE button when feeding from the Multi Purpose Tray. 
This can be useful if printing on envelopes.

Always create 100% black (K) toner

Select this option if you want the printer to always use only black 
(K) toner when printing pure black (RGB = 0,0,0). This is effective 
even when Composite Black (CMYK) is selected in the color 
options.

Run maintenance cycle before printing

Depending on printing habits and usage patterns, running the 
maintenance cycle before printing may ensure the best possible 
print quality. This feature uses the printer's image drums and 
transfer belt. The life of these printer consumables may be 
shortened if the printer runs a maintenance cycle frequently.

Print control

If you are using the Windows Print Control Server software to 
manage printers, enter your assigned user name and ID. This 
information is sent to the printer with your print job and is 
recorded by the printer.

Summary    

This option displays a summary of all selected print options for 
the current job. 
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Printing

This chapter describes how to carry out basic printing tasks 
using your printer.

Test printing

Print a demo page

1. Switch on the printer and allow it to warm up. 

2. Press the ENTER button on your printer to display INFORMATION 
MENU on the LCD. 

3. Press ENTER to select the menu.

4. Press the Down arrow until DEMO1 is displayed on the LCD.

5. Press ENTER to print the demo page.

Print the Menu map 

The Menu Map prints a list of all the printer's menus and their 
current settings.

1. Switch on the printer and allow it to warm up. 

2. Press the ENTER button on your printer to display INFORMATION 
MENU on the LCD. 

3. Press ENTER to select the menu.

4. PRINT MENU MAP is displayed on the LCD; press ENTER to print 
the Menu map.

2-sided printing (Windows only)
To carry out 2-sided, or Manual Duplex Printing you must pass 
paper through the printer twice. You can carry out 2-sided 
printing using the Cassette Tray or the Multi Purpose Tray. 

2-sided Printing is supported on Windows operating systems 
only.
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Manual duplex printing using the cassette tray

1. Ensure that there is enough paper in the cassette tray to carry 
out the print job.

2. Select File -> Print and click the Properties button. In the 2-
sided printing drop down menu, select either “Long Edge” or 
“Short Edge” according to your printing preferences. If you 
require further information, click the Duplex Help button. Then, 
Click the Print button. 

3. Every second page of your document is printed first. When this is 
complete, a message appears on screen prompting you to take 
the paper, flip it and replace it in the Cassette Tray.

4. Open the Cassette Tray.

     1-2_P paper out.jpg  
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5. Take the printed paper from the Output Stacker and place it in 
the Cassette Tray with the printed side facing up and the bottom 
of the page facing into the printer.

   1-4_P_paper in.jpg  

6. Close the Cassette Tray and press the ON LINE button as 
directed in the status message. The message window should 
disappear from your screen and the document finishes printing 
the remaining pages of your document.

  1-5_P _press online.jpg  

ON LINE

CANCEL
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Manual duplex printing using the Multi Purpose Tray

NOTE:
When using the Multi Purpose Tray, feed pages one sheet at a time. 

1. Position the paper guides on the Multi Purpose Tray according to 
the paper size.

2. Place paper one sheet at a time in the Multi Purpose Tray. The 
paper is automatically gripped in position.

3. Select File -> Print to display the Print dialog box.

4. Click the Properties button. On the 2-sided printing drop down 
menu, select either “Long Edge” or “Short Edge” according to 
your printing preferences. If you require further information, click 
the Duplex Help button

5. When every second page has printed, take the paper from the 
output stacker.     2-2_P_mpt_paper flip.jpg  

6. Set the paper one page at a time in the Multi Purpose Tray with 
the printed side facing down and the top of the page facing into 
the printer. Ensure that the paper is gripped in place.    2-

7. Press the ON LINE button. The remaining pages of your 
document print on the blank side of the paper. 
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Printing on different media
This section describes how to print on material other than 
normal Letter/A4 paper.

Printing on legal paper

When printing on legal paper you need to change the media 
settings for the printer software to get the best results.

You can either set a default driver for each type of media or 
you can change the print media settings through your 
Windows printer properties or Mac Print options any time you 
print on different media.

Printing on envelopes

NOTE:
Do not use envelopes with clear windows. Use paper envelopes only.

1. In the Multi Purpose Tray, adjust the paper guides using the 
indicators marked on the printer.

2. Place your envelopes in the tray, face up with the short edge 
facing into the printer and the flap to the right. Do not load more 
than 1 envelope at a time.

3. From your operating system, access the print media menu and 
select your envelope size.

4. Print in the usual manner for your operating system software.
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Setting other printing options
This sections briefly describes how to set printing options for 
your particular print job.

Fit to page printing

You can choose to print your document on larger or smaller 
sized paper depending on the size of print media available to 
you.

1. Insert paper in the Cassette Tray or Multi Purpose Tray in the 
usual manner. 

2. Select File -> Print and click the Properties button. Then click 
the Paper Feed Options button. Under Fit to Page, select the 
page size from the Conversion drop down list.

   Printing multiple pages to one sheet

In Windows, open the Printing Preferences Setup Tab. Under 
Finishing Mode, select the number of document pages that you 
want to print per sheet of paper from the drop down list.

Printing color documents in black and white

You can save both time and toner by printing color documents 
in black and white. Access the Color tab in printing properties 
and select the “Monochrome” option in Windows or the 
Grayscale option in Mac before printing your document.

Cancelling a print job
You can cancel a print job from your software application, from 
the print queue or by using the CANCEL button on your 
printer.        

PRINTING STATE HOW TO CANCEL 

Document has not 
started printing

Try to cancel printing job within software 
application

Document is waiting 
in a print queue

Delete print job from Print Queue. You can 
access the print queue from the System Tray 
in Windows or the Print Center Queue in Mac.

Document has 
started printing

Press the CANCEL button on your printer. 
Any pages that are already moving through 
the printer will be printed. You will need to 
press CANCEL for each print job you wish to 
stop.
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Color Printing

The printer drivers supplied with your printer provide several 
controls for changing the color output. For general use the 
automatic settings will suffice, providing reasonable default 
settings that will produce good results for most documents.

Many applications have their own color settings, and these 
may override the settings in the printer driver. Please refer to 
the documentation for your software application for details on 
how that particular program’s color management functions.

Factors that affect the appearance of prints
If you wish to manually adjust the color settings in your printer 
driver, please be aware that color reproduction is a complex 
topic, and there are many factors to take into consideration. 
Some of the most important factors are listed below.

Differences between the range of colors a monitor or 
printer can reproduce

> Neither a printer nor a monitor is capable of reproducing the full 
range of colors visible to the human eye. Each device is restricted 
to a certain range of colors. In addition to this, a printer cannot 
reproduce all of the colors displayed on a monitor, and vice versa.

> Both devices use very different technologies to represent color. A 
monitor uses Red, Green and Blue (RGB) phosphors (or LCDs), a 
printer uses Cyan, Magenta, Yellow and Black (CMYK) toner or 
ink.

> A monitor can display very vivid colors such as intense reds and 
blues and these cannot be easily produced on any printer using 
toner or ink. Similarly, there are certain colors, (some yellows for 
example), that can be printed, but cannot be displayed 
accurately on a monitor. This disparity between monitors and 
printers is often the main reason that printed colors do not match 
the colors displayed on screen.
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Viewing conditions 

A print can look very different under different lighting 
conditions. For example, the colors in a print may look 
different when viewed standing next to a sunlit window, 
compared to how they look under standard office fluorescent 
lighting.

Printer driver color settings

The driver settings for Manual color can change the 
appearance of a print. There are several options available to 
help match the printed colors with those displayed on screen.

Monitor settings

The brightness and contrast controls on your monitor can 
change how your document looks on-screen. Additionally, your 
monitor’s color temperature influences how “warm” or “cool” 
the colors look.

There are several settings found on a typical monitor:

> 5000k  Warmest; yellowish lighting, typically used in graphic art 
environments.

> 6500k  Cooler; approximates daylight conditions.

> 9300k  Cool; the default setting for many monitors and television 
sets.

         (k = degrees Kelvin, a measurement of temperature.)

How your software application displays color 

Some graphics applications such as Corel Draw or Adobe 
Photoshop may display color differently from “Office” 
applications such as Microsoft Word. Please see your 
application’s on-line help or user manual for more information.

Paper type 

The type of paper used can also significantly affect the printed 
color. For example, a printout on recycled paper can look duller 
than one on specially formulated high-quality paper.
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Tips for printing in color
The following guidelines may help you to achieve good color 
output from your printer.

Printing photographic images

Use the Monitor (6500k) Perceptual setting. 

If the colors look too dull, try the Monitor (6500k) Vivid or 
Digital Camera settings.

Printing from Microsoft Office applications

Use the Monitor (9300k) setting. This may help if you are 
having problems with specific colors from applications such as 
Microsoft Excel or Microsoft Powerpoint.

Printing specific colors (e.g., a company logo)

There are 2 utilities on your printer driver CD-ROM that can 
help match specific colors:

Color Correct Utility 

Color Swatch Utility 

Adjusting the brightness or intensity of a print

If the print is too light/dark, you can use the Brightness control 
to adjust it. 

If the colors are too intense/not intense enough, use the 
Saturation control.
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Accessing the color matching options
The Color Matching options in the printer driver can be used to 
help match your printed colors to the ones displayed on your 
monitor or from some other source, such as a digital camera.

To open color matching options from the Windows Control 
Panel:

1. Open the Printers window (called “Printers and Faxes” in 
Windows XP).

2. Right-click the printer name and choose Properties.

3. Click the Printing Preferences button.

To open color matching options from within a Windows 
application:

1. Choose File—Print… from the application’s menu bar.

2. Click the Properties button next to the printer name.
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Setting the color matching options
1. On the Color tab select Advanced Color for Color Matching.   

2. Choose the Manual color setting and select from the following 
options:    

(a) Monitor (6500k) Perceptual

Optimized for printing photographs. Colors are printed with 
emphasis on saturation.

(b) Monitor (6500k) Vivid

Optimized for printing photographs, but with even more 
saturated colors than the Monitor (6500k) Perceptual 
setting.

(c) Monitor (9300k)

Optimized for printing graphics from applications such as 
Microsoft Office. Colors are printed with emphasis on 
Lightness. 

(d) Digital Camera

Optimized for printing photographs taken with a digital 
camera. 

Your results will vary depending on the subject and the 
conditions under which the photograph was taken. 

(e) sRGB

The printer will try to reproduce the sRGB color space. This 
may be useful if color matching from an sRGB input device 
such as a scanner or digital camera.
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Using the Color Swatch feature
To use the Color Swatch feature, you must install the Color 
Swatch Utility. This is supplied on the CD-ROM that was 
supplied with your printer.

The Color Swatch function prints charts which contain a range 
of sample colors. Note that this is not the full range of colors 
that the printer can produce. Listed on each sample color are 
the corresponding RGB (Red, Green, Blue) values. This can be 
used to pick specific colors in applications that allow you to 
choose your own RGB values. Simply click the Color Swatch 
button and choose from the options available.    

An example of using the Color Swatch function:

You wish to print a logo in a particular shade of red. The steps 
you would follow are:

1. Print a color swatch, then select the shade of red that best suits 
your needs. 

2. Take a note of the RGB value for the particular shade that you 
liked.

3. Using your program’s color picker, enter these same RGB values, 
and change the logo to that color.

The RGB color displayed on your monitor may not necessarily 
match what was printed on the color swatch. If this is the case, 
it is probably due to the difference between how your monitor 
and printer reproduce color. Here, it is unimportant since your 
primary objective is to print the required color.
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Using the Color Correct Utility
The Oki Color Correct Utility is provided on your printer driver 
CD-ROM. You must install it separately since it is not installed 
along with the printer driver.

The Color Correct utility has the following features:

> Microsoft Office palette colors can be individually adjusted. This is 
useful if you want to change how a specific color is printed.

> Colors can be adjusted by changing Hue, Saturation and Gamma. 
This is useful if you wish to change the overall color output. 

Once these color adjustments have been made, the new 
settings can be selected from the printer driver Color tab.

To select adjustments made with the Color Correct 
Utility:

1. From your application program, click File and point to Print.

2. Click Properties. This displays the printer driver options.

3. Click the Color tab.

4. Click Advanced Color.

5. Click User Defined.

Select the color adjustment you made with the Color Correct 
Utility.
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Using the printer software 

Status Monitor (Windows only)
The Status Monitor software is distinct from and installed 
separately from the driver software.

   

The Status Monitor provides a readable indication of the 
printer status as displayed on the indicator LEDs on the 
Operation Panel (see “The Operation Panel” on page 10) and 
allows you to access the printer menus (listed at the end of this 
chapter) to set printer parameters such as paper size etc.

       

Using the Status Monitor

    

Viewing the status of the printer, and viewing or changing the 
printer menu settings are carried out though the Status 
Monitor. Click on [Start], [All Programs] and select 
Okidata|OKI 3600| Status Monitor. The current printer 
status is shown.    

Printer State tab

This tab is visible by default on opening the Status Monitor and 
displays detailed information about the status of the printer.

NOTE

For reliable operation of the Status Monitor, ensure that the 
USB cable is of length 2 m (78.74 in.) maximum.

NOTE

The Status Monitor is available to Windows operating systems 
only. Mac OS X has a “Printer Menu” utility that allows you to 
change the user settings outlined in this chapter.

NOTE

You are advised to refer to the extensive on-line help as 
required when using the Status Monitor.
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Printer Setup tab

Selecting this tab provides access to the Select Printer 
button, which, when selected, allows you to monitor the status 
any printer configured for use with your computer. 

The Printer Menu button enables you to access the printer 
menu settings.    

From the printer menu, you can configure your printer 
settings.     

Preferences tab 

Selecting this tab provides the means to choose the 
information displayed by the Status Monitor and how/when the 
Status Monitor appears.     

The default Alert view setting (Pop up on alerts) ensures that 
the Status Monitor pops up to inform you of a condition that 
requires your attention; e.g., paper out in Cassette Tray.

Printer functions (User Settings)
The printer settings made from the Status Monitor can be seen 
collectively on a printed Menu Map (or Status Page). 

User Settings

On the Status Monitor Setup tab, click Printer Menu. The User 
Settings Print Menu appears. You change user settings options 
from this menu.

To save your changes, click the Apply the changed settings 
icon, in the top left hand corner. To undo a change, click the 
Undo changed settings icon. 

Administrator Settings

This menu is intended to be used only by designated staff.

On the User Settings window, select Display -> Administrator 
Menu. The User Settings menu is updated to include the 
Administrator menu options.    

The Administrator Settings menu has the settable items, 
including access to the user menus. If you disable a menu from 
this tab, it does not appear on the User Settings tab.

To save your changes, click the “Apply the changed settings” 
icon (as shown below), in the top left hand corner.   
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To undo a change, click the Undo changed settings icon.  

   

It should be noted that many of these settings can be, and 
often are, overridden by settings made in the printer drivers. 
However, several of the driver settings can be left at “Printer 
Setting”, which will then default to the settings entered in 
these printer menus.

Factory default settings are shown in bold type in the 
following tables.

Printer Menu utility (Mac only)
There is no status monitor in Mac. You can change printer user 
settings through the Printer Menu utility.

You can use Windows Print Control Server Software to manage 
your printer in Mac. For more information, see “Printing From 
Mac” on page 31

NOTE

You can access the printer menu settings window direct by 
clicking [Start], [All Programs] and selecting Okidata|OKI 
C3600n|Printer Name Printer Settings.
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Printer menus

NOTE: 
Each menu can be disabled or enabled in the Administration Menu. If 
a menu is disabled, it will not appear on the LCD list of menus. 

Information menu
This menu provides a quick method of listing various items 
stored within the printer.

  
INFORMATION MENU

ITEM ACTION EXPLANATION

PRINT MENU MAP / 
STATUS PAGE 
PRINT

EXECUTE Prints complete menu listing with 
current settings shown.

COLOR PROF LIST EXECUTE Prints a list of stored color profiles.
USAGE REPORT EXECUTE Prints a list of the number of color and 

mono pages printed.
PRINT ERROR LOG EXECUTE Prints a list of all errors and warnings 

that occurred on the printer.
DEMO1 EXECUTE Prints a demonstration page containing 

graphics and text in color and 
monochrome.

PRINT FX FONT EXECUTE Prints complete list of all internal Epson 
FX emulation fonts, including any 
downloaded to flash memory or hard 
disk.

PRINT PPR FONT EXECUTE Prints complete list of all internal IBM 
ProPrinter III XL emulation fonts, 
including any downloaded to flash 
memory or hard disk.

PRINT PSE FONT EXECUTE Prints complete list of all internal 
Postscript emulation fonts.

PRINT PCL FONT EXECUTE Prints complete list of all internal PCL 
fonts, plus those stored in ROM (slot 
0), flash memory and in hard disk (if 
installed).

PRINT FILE LIST EXECUTE Prints a list of overlays, macros, fonts 
and other files stored on the printer’s 
hard disk drive (if installed).

NETWORK EXECUTE Prints a page that lists the printer’s 
current network settings.
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Shut down menu
This menu provides an option to ensure that your printer can 
be safely switched off. 

  

Print menu
This menu provides adjustment of various print job related 
functions.

     

SHUT DOWN MENU

ITEM ACTION EXPLANATION

SHUT DOWN 
START

EXECUTE Prepares printer to be safely switched 
off. 

PRINT MENU

ITEM SETTINGS EXPLANATION

COPIES 1-999 Enter the number of copies of a 
document to be printed from 1 to 999.

MANUAL FEED 
(Multi Purpose 
Tray)

ON/OFF Selects the default tray for paper feed, 
Cassette Tray or Multi Purpose Tray.

MEDIA SIZE 
CHECK

ENABLE 
DISABLE

Determines whether the printer checks 
the size of paper loaded matches that 
required for the document sent to print.

RESOLUTION 600DPI

600 x 1200 
DPI

600DPI  
M-LEVEL

Sets the default resolution for printing 
(dots per inch). 600 x 1200 dpi uses 
more memory and requires more time to 
process, but prints at a higher quality.

TONER SAVE 
MODE

ON

OFF

Reduces the amount of toner used for 
imaging. Toner saving produces lighter 
prints but is more economical.

MONO-PRINT 
SPEED

AUTO 
COLOR 
NORMAL

Selects the printer's print engine speed 
for the type of print media in use.

ORIENTATION PORTRAIT

LANDSCAPE

Selects the default page orientation: 
portrait (tall) or landscape (wide). 

[PCL, IBMPPR, and EPSON FX only]
LINES PER PAGE 5~64~128 Sets the number of lines of text per page 

when raw text is received from systems 
other than Windows. The default for A4 
portrait is 65, and for Letter is 60.
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EDIT SIZE CASSETTE 
SIZE

AR / A5 / A6 / 
B5

LEGAL14

LEGAL13.5

LEGAL13

LETTER

EXECUTIVE

CUSTOM

COM-9 
ENVELOPE

COM-10 
ENVELOPE

MONARCH 
ENVELOPE

DL ENVELOPE

C5 ENVELOPE

Sets the size of the printable page area 
to match the size of paper in use. This is 
not the same as the physical paper size, 
which is always slightly larger. For 
dimensions of physical page sizes, see 
“Paper Recommendations” in this guide.

PRINT MENU

ITEM SETTINGS EXPLANATION
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Media menu
This menu provides adjustments to suit a wide range of print 
media.

  
MEDIA MENU

ITEM SETTINGS EXPLANATION

TRAY 
PAPERSIZE

(MEDIA SIZE)

A4 / A5 / A6 / B5 
LETTER 
EXECUTIVE 
LEGAL14 
LEGAL13 
LEGAL13.5 
CUSTOM

Selects the size of paper loaded in 
Tray 1. For CUSTOM setting see 
X-DIMENSION and Y-DIMENSION 
later in this table.

TRAY 

- MEDIA TYPE

PLAIN 
LETTERHEAD 
BOND 
RECYCLED 
ROUGH 
GLOSSY 
CARD STOCK 
LABELS 
USERTYPE1 - 5

Selects the type of media loaded 
in this tray. This will help the 
printer to adjust its internal 
operating parameters, such as 
engine speed and fusing 
temperature, to better 
accommodate the media to be 
fed. For example, letterhead may 
benefit from a slightly lower 
fusing temperature to ensure that 
its ink does not offset. Usertype 
1 – 5 will be displayed only when 
registered from the host PC.

TRAY 

- MEDIA 
WEIGHT

MEDIUM 

   20-24 lb. 
   75-90 g/m²

HEAVY

  24-32 lb. 
  91-120 g/m²

ULTRA HEAVY

   32-54 lb. 
   121-203 g/m²

Adjusts the printer for the weight 
of paper stock loaded in this tray.
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MANUAL (Multi 
Purpose Tray)

- PAPER SIZE

A4 / A5 / A6 / B5/
LETTER 
EXECUTIVE 
LEGAL14 
LEGAL13 
LEGAL13.5 
CUSTOM 
COM-9 ENVELOPE 
COM-10 ENVELOPE 
MONARCH ENV 
DL ENVELOPE 
C5 ENVELOPE

Selects the size of paper to be fed 
from the Multi Purpose Tray. For 
CUSTOM setting see X-
DIMENSION and Y-DIMENSION 
later in this table.

MANUAL (Multi 
Purpose Tray)

- MEDIA TYPE

PLAIN 
LETTERHEAD 
LABELS 
BOND 
RECYCLED 
CARD STOCK 
ROUGH 
GLOSSY 
USERTYPE1 – 5

Selects the type of media to be 
fed from the Multi Purpose Tray 
so that the printer can adjust its 
internal parameters to better 
accommodate the selected type 
of media. Usertype 1 – 5 will be 
displayed only when registered 
from the host PC.

MANUAL (Multi 
Purpose Tray)

- MEDIA 
WEIGHT

MEDIUM 

   20-24 lb. 
   75-90 g/m²

HEAVY

  24-32 lb. 
  91-120 g/m²

ULTRA HEAVY

   32-54 lb. 
   121-203 g/m²

Selects the media weight to be 
fed from the Multi Purpose Tray.

UNIT OF 
MEASURE

CUSTOM PAPER 
SIZE - MEDIA 
SIZE UNIT

MILLIMETRE 
INCH

Selects the unit of measure for 
the next two items.

X DIMENSION

CUSTOM PAPER 
SIZE - MEDIA 
WIDTH

2.52-8.27-8.5 
inches

64-210-216 
millimetres

Selects the width of paper defined 
by the “CUSTOM” settings 
referred to in the foregoing PAPER 
SIZE settings.

Y DIMENSION

CUSTOM PAPER 
SIZE - MEDIA 
LENGTH

5.83-11-47.24 
inches

148-297-1200 
millimetres

Selects the length of paper 
defined by the “Custom” settings 
referred to in the foregoing PAPER 
SIZE settings. Note that media of 
up to 47.24 in (1200 mm) in 
length can be fed from the Multi 
Purpose Tray for banner printing.

MEDIA MENU

ITEM SETTINGS EXPLANATION
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Color menu
The printer automatically adjusts color balance and density at 
appropriate intervals, optimizing the printed output for bright 
white paper viewed in natural daylight conditions. The items 
on this menu provide a means of changing the default settings 
for special or particularly difficult print jobs. Settings revert to 
their default values when the next print job is complete.

  
COLOR MENU

ITEM SETTINGS EXPLANATION

DENSITY 
CONTROL 
ADJUSTMENT 
MODE

AUTO 
MANUAL

If set to AUTO, image density will be 
automatically adjusted at power on, 
when a new image drum or toner 
cartridge is installed, and at intervals 
of 100, 300 and 500 drum counts. If 
a 500 drum count interval occurs 
during a print job it will occur at the 
end of that job, and will take up to 
55 seconds. If set to MANUAL, this 
adjustment will only be performed 
when initiated by the next menu 
item.

CMYK 
CONVERSION

ON 
OFF

To simplify the conversion process of 
CMYK data and reduce processing 
time, set to OFF. Notes: This setting 
is ignored when Ink Simulation is 
used. This setting only applies to PS 
models.

CMY 100% 
DENSITY

DISABLE 
ENABLE

When enabled, black areas are 
produced using 100% C, M, and Y 
instead of black. This results in a 
glossier finish.

UCR LOW 
MEDIUM 
HIGH

Selects a limitation of the toner layer 
thickness. If paper curling occurs in 
dark printing, selecting MEDIUM or 
LIGHT may reduce curling.

INK 
SIMULATION

OFF 
SWOP 
EUROSCALE 
JAPAN

Selects from a range of industry-
standard color swatches. Note: This 
setting only applies to PS models.

DENSITY 
ADJUSTMENT

EXECUTE Selecting this will perform the auto 
density set up immediately.
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ADJUSTMENT 
REGISTRATION

(Color 
Registration 
Adjustment)

EXECUTE Performs automatic color 
registration adjustment. Normally 
this is done on power on and when 
the top cover is opened and then 
closed. This process accurately 
aligns the cyan, magenta and yellow 
images to the black image. Note: 
Make sure the printer is idle before 
changing this setting.

Position 
Registration 
Fine Adjustment

C REG FINE 
ADJUST

M REG FINE 
ADJUST

Y REG FINE 
ADJUST

 
 
-3~0~+3 

-3~0~+3 

-3~0~+3

Performs fine adjustment of image 
timing in relation to the black image 
component.

Darkness 
Settings

C DARKNESS

M DARKNESS

Y DARKNESS

K DARKNESS

 

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

Adjusts the darkness of each color 
component (Cyan, Yellow, Magenta, 
and Black). Normal setting is “0”.

Image Density 
Settings

C HIGHLIGHT

C MID-TONE

C DARK

M HIGHLIGHT

M MID-TONE

M DARK

Y HIGHLIGHT

Y MID-TONE

Y DARK

K HIGHLIGHT

K MID-TONE

K DARK

 

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

-3~0~+3

Adjusts image density for each color 
component (Cyan, Yellow, Magenta, 
and Black). Normal setting is “0”.

COLOR TUNING PRINT  
PATTERN

Selecting this item prints the Color 
Tuning Pattern swatches that can 
help you adjust the color balance. 

COLOR MENU

ITEM SETTINGS EXPLANATION
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System configuration menu
This menu adjusts general printer settings to suit the way you 
prefer to work.

    
SYSTEM CONFIGURATION MENU

ITEMS SETTINGS EXPLANATION

TIME TO POWER 
SAVE MODE

5 MIN 
15 MIN 
30 MIN 
60 MIN 
240 MIN

Adjusts the idling time before the 
printer automatically switches into 
power saving mode. In this mode 
power consumption is reduced to a 
low level required to just keep the 
printer operating and ready to 
receive data. When a job is sent the 
printer will require a warm-up time 
of up to 1 minute before printing can 
begin.

CLRABLE 
WARNING

(CLEAR 
ALARMS)

ONLINE 
JOB

When ON LINE, non-critical 
warnings, such as requests for a 
different paper size, can be cleared 
by pressing the ON LINE button. 
When set to JOB, they are cleared 
when the print job resumes.

MANUAL FEED 
(Multi Purpose 
Tray) TIMEOUT

OFF 
30~60~120~ 
200~30 
seconds

Specifies how many seconds the 
printer will wait for paper to be fed 
in manual feed mode before 
cancelling the job.

WAIT TIMEOUT OFF 
5~10~20~30~
40~300 
seconds

Specifies how many seconds the 
printer will wait when received data 
pauses before forcing a page eject. 
In Postscript Emulation mode the job 
will be cancelled if timeout occurs. 

AUTO 
CONTINUE

OFF

ON

Determines whether or not the 
printer will automatically recover 
from a memory overflow error.

NET PS 
PROTOCOL

RAW

ASCII

Selects PostScript data format for 
the network port.

USB PS 
PROTOCOL

RAW

ASCII

Selects PostScript data format for 
the USB port.

LOW TONER

(PRINT 
CONTINUATION 
AT TONER 
SHORTAGE)

CONTINUE 
STOP

Specifies whether the printer should 
continue printing even after a low 
toner condition is detected.
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JAM RECOVERY ON 
OFF

Specifies whether the printer should 
perform jam recovery after a paper 
jam has occurred. If ON, the printer 
will attempt to print again any pages 
lost due to a paper jam once the jam 
has been cleared.

ERROR REPORT ON 
OFF

Specifies whether to print an error 
report when an internal error occurs. 
Note: Applies to PS and PCL XL 
only.

PERSONALITY AUTO 
EMULATION

PS3 
EPSON FX 
IBM PPR III XL 
PCL

Selects which industry-standard 
emulation the printer should use. 
When set to AUTO, incoming data is 
examined and the correct emulation 
is automatically selected each time a 
print job is received.

SYSTEM CONFIGURATION MENU

ITEMS SETTINGS EXPLANATION
C3600n User’s Guide
66



PCL Emulation menu
This menu controls the settings that are in effect when the 
printer is operating in PCL emulation mode.

   
PCL EMULATION MENU

ITEM SETTINGS EXPLANATION

FONT SOURCE RESIDENT / 
RESIDENT2 
DOWNLOADED

Specifies the location of the PCL 
default font. Normally this will be 
INTERNAL unless additional fonts 
are installed in the expansion ROM 
slot or additional fonts have been 
downloaded to RAM as permanent 
fonts.

FONT No. I0 / C001 / 
S001

Sets the current default font number 
from the currently selected source, 
which could be internal (I), ROM slot 
(C) or downloaded (S).

FONT PITCH 0.44CPI~ 
10.00CPI~ 
99.99CPI

Sets the width of the PCL default 
font in characters/inch (CPI).

Default font is the fixed-pitch, 
scalable font. The value is displayed 
to the second decimal place 

Displayed only when the font 
selected in Font No. is fixed-spacing, 
scalable font.

SYMBOL SET PC-8

(Default Symbol 
Set only shown)

PCL symbol set. If the font source 
and number are changed to one 
which does not support the selected 
symbol set, this must be changed to 
an available symbol set for that font.

A4 PRINT 
WIDTH

78 COLUMN 
80 COLUMN

Sets the number of columns subject 
to Auto LF with A4 paper in PCL. 
This is the value when Auto CR/LF 
Mode is set to OFF with the 10CPI 
character.

WHITE PAGE 
SKIP

OFF  
ON

Selects whether blank pages are 
printed or not.

CR FUNCTION

(Carriage 
Return)

CR  
CR+LF

Selects whether a received carriage 
return character (0Dh) also causes a 
line feed.

LF FUNCTION

(Line Feed)

LF

LF+CR

Selects whether a received line feed 
character (0Ah) also causes a 
carriage return.

PRINT MARGIN NORMAL 
1/5 INCH 
1/6 INCH

Sets the non-printable page area. 
NORMAL is PCL-compatible.
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TRUE BLACK OFF  
ON

Selects whether black image data is 
printed using black toner (ON) or 
100% CMY (OFF). (Valid in PCL 
emulation mode only.)

PEN WIDTH 
ADJUST

ON 
OFF

Set to ON when minimum width 
specified, to stretch a one-dot line 
and eliminate gaps.

TRAY ID# MP TRAY 
1-2-59

Specifies a tray number.

PCL EMULATION MENU

ITEM SETTINGS EXPLANATION
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PPR Emulation menu
This menu controls the settings that are in effect when the 
printer is operating in PPR emulation mode.

   
PPR EMULATION MENU

ITEM SETTINGS EXPLANATION

CHARACTER 
PITCH

10 CPI  
12 CPI 
17 CPI 
20 CPI 
PROPORTIONAL

Specifies character pitch in IBM PPR 
emulation.

FONT 
CONDENSE

12CPI - 20CPI 
12CPI - 12CPI

Specifies 12CPI pitch for Condense 
Mode.

CHARACTER 
SET

Set 1  
Set 2

Specifies a character set.

SYMBOL SET IBM 437

(Default Symbol 
Set only shown)

Specifies a symbol set.

LETTER 0 STYLE DISABLE  
ENABLE

Specifies the style that replaces 9BH 
with the letter o and 9DH with a 
zero.

ZERO 
CHARACTER

NORMAL 
SLASHED

Sets the zero to be slashed or un-
slashed.

LINE PITCH 6 LPI 
8 LPI

Specifies the line spacing (lines per 
inch).

WHITE PAGE 
SKIP

OFF 
ON

Selects whether blank pages are 
printed or not.

CR FUNCTION

(Carriage 
Return)

CR 
CR+LF

Selects whether a received carriage 
return character (0Dh) also causes a 
line feed.

LF FUNCTION

(Line Feed)

LF 
LF+CR

Selects whether a received line feed 
character (0Ah) also causes a 
carriage return.

LINE LENGTH 80 COLUMN 
136 COLUMN

Specifies the number of characters 
per line.

FORM LENGTH 11 Inch 
11.7 Inch 
12 Inch

Specifies the length of paper.

TOF POSITION 0.0 INCH -  
1.0 INCH

Specifies the distance of print from 
the top edge of the paper.

LEFT MARGIN 0.0 INCH -  
1.0 INCH

Specifies the distance of print from 
the left hand edge of the paper.
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FIT TO LETTER DISABLE 
ENABLE

Sets the printing mode that can fit 
print data, equivalent to 11 inches 
(66 lines), in the LETTER-size 
printable area.

TEXT HEIGHT SAME 
DIFF

Sets character height:  
SAME: Regardless of CPI, same 
height. DIFF (Different): As CPI, 
character heights vary.

PPR EMULATION MENU

ITEM SETTINGS EXPLANATION
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FX Emulation menu
This menu controls the settings that are in effect when the 
printer is operating in FX emulation mode.

   
FX EMULATION MENU

ITEM SETTINGS EXPLANATION

CHARACTER 
PITCH

10 CPI; 
12 CPI; 17 CPI; 
20 CPI; 
PROPORTIONAL

Specifies character pitch in this 
emulation.

CHARACTER 
SET

Set 1 
Set 2

Specifies a character set.

SYMBOL SET IBM 437 
(Default Symbol 
Set only shown)

Specifies a symbol set.

LETTER 0 STYLE DISABLE  
ENABLE

Specifies the style that replaces 9BH 
with the letter o and 9DH with a 
zero.

ZERO 
CHARACTER

NORMAL 
SLASHED

Sets the zero to be slashed or un-
slashed.

LINE PITCH 6 LPI 
8 LPI

Specifies the line spacing.

WHITE PAGE 
SKIP

OFF 
ON

Selects whether blank pages are 
printed or not.

CR FUNCTION

(Carriage 
Return)

CR  
CR+LF

Selects whether a received carriage 
return character (0Dh) also causes a 
line feed.

LINE LENGTH 80 COLUMN 
136 COLUMN

Specifies the number of characters 
per line.

FORM LENGTH 11 inch 
11.7 inch 
12 inch

Specifies the length of the paper.

TOF POSITION

(Top of Form)

0.0 inch -  
1.0 inch

Specifies the distance at which 
printing starts, from the top edge of 
the paper.

LEFT MARGIN 0.0 inch -  
1.0 inch

Specifies the distance at which 
printing starts, from the left-hand 
edge of the paper.

FIT TO LETTER DISABLE 
ENABLE

Sets the printing mode that can fit 
print data, equivalent to 11 inches 
(66 lines), in the LETTER-size 
printable area.

TEXT HEIGHT SAME 
DIFF

Sets the character height: 
SAME: Regardless of CPI, same 
height. DIFF: As CPI, character 
heights vary.
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USB menu
This menu controls the operation of the printer’s USB data 
interface.

   

NOTE
When you have changed any settings in the USB MENU, turn the 
printer OFF, then ON again.

Network menu
This menu controls the printer’s 10Base-T/100Base-TX 
network interface.

    

USB MENU

ITEM SETTINGS EXPLANATION

SOFTWARE 
RESET

ENABLE 
DISABLE

Enables or disables the SOFT RESET 
command. (Only available on 
Windows 98 and Windows Me.)

MAXIMUM 
SPEED

12 MBPS 
480 MBPS

Specifies the maximum transfer 
speed.

OFFLINE 
RECEIVE

ENABLE 
DISABLE

Offline receive.

SERIAL NUMBER ENABLE 
DISABLE

Specifies the USB serial number to 
differentiate between USB devices 
connected to the PC. If ENABLED, 
the serial number is transmitted. If 
DISABLED, the serial number is not 
transmitted.

NETWORK MENU

ITEM SETTINGS EXPLANATION

TCP/IP ENABLE 
DISABLE

Enables or disables this network 
protocol.

IP VERSION IP V4 

IPV 4 & V6

IPV 6

Sets up the IP version: 
- Operates with IPv4 only (not valid 
with IPv6). 
- Operates with both IPv4 and IPv6. 
- Operates with IPv6 only (not valid 
with IPv4).

NETBEUI ENABLE 
DISABLE

Enables or disables this network 
protocol.

IP ADDRESS 
SET

AUTO  
MANUAL

Specifies whether IP address 
allocation is automatic (DHCP) or 
manually assigned.
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IP ADDRESS xxx.xxx.xxx.xxx Current assigned IP address. To 
change, press ENTER and use +/– 
keys to increment 1st octet, then 
press ENTER again to move on to 
next octet. When 4th octet has been 
set, press ENTER again to register 
new address.

SUBNET MASK xxx.xxx.xxx.xxx Current assigned subnet mask. To 
change, proceed as above.

GATEWAY 
ADDRESS

xxx.xxx.xxx.xxx Current assigned gateway address. 
To change, proceed as above.

WEB ENABLE 
DISABLE

Enables or disables Web 
configuration facility.

TELNET ENABLE 
DISABLE

Enables or disables Telnet 
configuration facility.

FTP ENABLE 
DISABLE

Enables or disables communication 
via FTP (File Transfer Protocol).

SNMP ENABLE 
DISABLE

Enables or disables SNMP protocol 
(Simple Network Management 
Protocol).

NETWORK 
SCALE

NORMAL 
SMALL

Selects network size.

When NORMAL is selected, printer 
can work effectively, even when 
connected to a HUB that has a 
spanning tree feature. However, 
printer start up time gets longer 
when computers are connected with 
two or three small LANs.

When SMALL is selected, computers 
can cover from two or three small 
LANs to a large LAN, but may not 
work effectively when connected to 
a HUB that has a spanning tree 
feature.

HUB LINK 
SETTING

AUTO 
NEGOTIATE 
100BASE-TX 
FULL 
100BASE-TX 
HALF 
10BASE-T FULL 
10BASE-T HALF

Sets full or half duplex for 
communication via a network hub.

When AUTO is set, negotiation is 
done automatically.

NETWORK MENU

ITEM SETTINGS EXPLANATION
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Maintenance menu
This menu provides access to various printer maintenance 
functions. 

    
MAINTENANCE MENU

ITEM SETTINGS EXPLANATION

MENU RESET EXECUTE Resets menus to default settings.
SAVE MENU EXECUTE Saves the current menu settings. 

The last menu executed is saved 
and the menu previously saved is 
overwritten and erased.

When you press the ENTER button, 
this confirmation message is 
displayed: DO YOU WANT TO 
EXECUTE THIS FUNCTION? YES/NO

To return the display to the previous 
menu without changes, select NO.

To store the current menu settings 
and exit the menu, select YES.

RESTORE MENU EXECUTE Changes to the menu setting saved.

When the Enter button is pressed, 
this confirmation message is 
displayed: ARE YOU SURE? YES/NO

If NO is selected, the previous menu 
display resumes. If YES is selected, 
changes made to the menu setting 
are saved and you exit from the 
menu.

Notes: This cannot be executed 
when data is printing.

This menu item will only show if the 
menu has been saved previously.

POWER SAVE 
MODE

ENABLE 
DISABLE

Enables or disables automatic power 
save mode. Delay before entering 
this mode is set in the system 
configuration menu.

PAPER BLACK 
SET

–2~0~+2 Used for small adjustment when you 
experience faded print or light 
specks / streaking in monochrome 
printing on white paper. Select a 
higher value to reduce fading, or a 
lower value to reduce specks or 
streaking in high density print areas.

PLAIN PAPER 
Color SET

–2~0~+2 As above, but for color printing.
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SMR SETTING –2~0~+2 Sets a correction value for uneven 
print quality, to correct print 
variations caused by variations in 
temperature and humidity or in print 
density/frequency.

BG SETTING –3~0~+3 Sets a correction value for dark-
colored paper printing, to correct 
print variations caused by variations 
in temperature and humidity or in 
print density/frequency.

MAINTENANCE MENU

ITEM SETTINGS EXPLANATION
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Usage menu
This menu is for information only, and provides an indication 
of total usage of the printer and the expected life left in its 
consumable items. This is particularly useful if you do not have 
a full set of replacement consumables on hand and you need 
to know how soon you will need them.

    
USAGE MENU

ITEM EXPLANATION

TRAY PAGE COUNT The total number of pages printed (excluding 
any pages that have jammed).

MN (Manual Tray) 
PAGE COUNT

The total number of pages fed from the Multi 
Purpose Tray.

Consumable Life

- BLACK (K) DRUM  
- C DRUM  
- M DRUM  
- Y DRUM  
- BELT  
- FUSER 

Percentage of life remaining in these consumable 
items.

Toner Life

- BLACK (K)  
- CYAN (C)  
- MAGENTA (M)  
- YELLOW (Y)

Current toner level.
C3600n User’s Guide
76



Print Statistics menu
This menu keeps track of printing statistics.

    
PRINT STATISTICS MENU

ITEM SETTINGS EXPLANATION

ENTER 
PASSWORD

nnnn Enters a password to enter Print 
Statistics menu.

The default password is "0000."
USAGE REPORT ENABLE 

DISABLE
Prints a list of jobs carried out on 
this printer. 

RESET 
COUNTER

EXECUTE Zeros the counter

GROUP 
COUNTER

ENABLE 
DISABLE

Sets Group Counter to display 
(ENABLE) or not display (DISABLE).

CHANGE 
PASSWORD

Enables change of the Password

NEW 
PASSWORD

**** Sets a new password

VERIFY 
PASSWORD

**** Verifies the change
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Printing settings
To print a list of the printer settings:

1. Start the Status Monitor.

2. Select the Printer Setup tab.

3. Click on the Printer Settings button on the Printer Setup tab.

4. Click on the Information menu and then select Print Menu Map.

5. Click on the Printer Menu button to print a Menu Map of printer 
settings.

    

Changing the Status Monitor Display Language
If required, carry out the following instructions to change the 
language that is displayed in the Status Monitor.

1. Start the Status Monitor.

2. Select the Printer Setup tab.

3. Click on the Printer Settings button on the Printer Setup tab.

4. In the System Configuration menu, select the required language.

5. Click on the Save button.

NOTE

A menu map of printer settings can also be printed from the 
Status Panel by holding down the ON LINE button for 2 
seconds.
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Replacing Consumables and Maintenance 
Items

NOTE: Fusers and transfer belts are replaceable maintenance items. 
They are warranted against defects for 90 days. When the printer 
display indicates that they are near end of life, a replacement must be 
purchased.

Life Expectancy
See “Specifications” on page 112.

Part Numbers
Toner

Black, standard 43459404 

Cyan, standard 43459403 

Magenta, standard 43459402 

Yellow, standard 43459401 

Black, high capacity 43459304 

Cyan, high capacity 43459303 

Magenta, high capacity 43459302 

Yellow, high capacity 43459301 

Image Drum
Black 43460204 

Cyan 43460203 

Magenta 43460202 

Yellow 43460201 

Fuser
120 V 43377003 

230V 43377004 

Belt
Belt 43378002 

Memory
256 MB RAM 43363304 

512 MB RAM 43363305 

Only use genuine Oki Original products to ensure the best quality and 
performance from your hardware. Non Oki Original products may 
damage your printer's performance and invalidate your warranty. 
Specifications subject to change without notice. 



Toner cartridge replacement

The toner used in this printer is a very fine dry powder. It is 
contained in four cartridges: one each for cyan, magenta, 
yellow and black.

Have a sheet of paper handy so that you have somewhere to 
place the used cartridge while you install the new one.

Dispose of the old cartridge responsibly by placing it inside the 
pack that the new one came in. Follow any regulations, 
recommendations, etc., which may be in force concerning 
waste recycling.

If you do spill any toner powder, lightly brush it off. If this is 
not enough, use a cool, damp cloth to remove any residue. Do 
not use hot water, and never use solvents of any kind. They 
will make stains permanent.

     

Before changing the toner cartridge, switch off the printer and 
allow the fuser to cool for about 10 minutes before opening the 
cover.

CAUTION!

To avoid toner wastage and possible toner sensor 
errors, do not change the- toner cartridge(s) until 
“TONER EMPTY” is displayed through the Status 
Monitor.

WARNING!
If you inhale any toner or get it in your eyes, drink a 
little water or bathe your eyes liberally in cold water. 
Seek medical attention immediately.
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1. Press the cover release and open the printer’s top cover fully. 

     cover open button_F5_23.jpg  

 

2. Note the positions of the 4 cartridges.

     ID Positions_Fig1_04.jpg  

    

WARNING!
If the printer has been powered on, the fuser may be 
hot. This area is clearly labelled. Do not touch this area.

1. Cyan cartridge 2. Magenta cartridge

3. Yellow cartridge 4. Black cartridge

1

2

3

4

C3600n User’s Guide
81



3. Carry out one of the following:

(a) If you are replacing a toner cartridge that has been supplied 
with your printer (release lever has 3 positions), pull the 
colored toner release lever on the cartridge to be replaced 
towards the front of the printer, in the direction of the 
arrow, but stop at the central (upright) position (1).

      Toner 3 positions_2.eps 

(b) If you are replacing any other toner cartridge (lever has 2 
positions), pull the colored toner release lever (1) on the 
cartridge to be replaced fully towards the front of the 
printer.

      Toner unLock_F5_01.jpg  

4. Lift the right-hand end of the cartridge and then draw the 
cartridge to the right to release the left-hand end as shown, and 
withdraw the toner cartridge from the printer (2).

1

2
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5. Put the cartridge down gently onto a piece of paper to prevent 
toner from marking your furniture.

   

6. Remove the new cartridge from its box but leave its wrapping 
material in place for the moment.

7. Gently shake the new cartridge from end to end several times to 
loosen and distribute the toner evenly inside the cartridge.

     Shake.jpg  

8. Remove the wrapping material and peel off the adhesive tape 
from the underside of the cartridge.

     Tape.jpg  

CAUTION!

The green image drum surface is very delicate and light 
sensitive. Do not touch it and do not expose it to normal 
room light for more than 5 minutes. If the drum unit 
needs to be out of the printer for longer than this, please 
wrap the cartridge inside a black plastic bag to keep it 
away from light. Never expose the drum to direct 
sunlight or very bright room lighting.
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9. Holding the cartridge by its top center with the colored lever to 
the right, lower it into the printer over the image drum unit from 
which the old cartridge was removed.

10. Insert the left end of the cartridge into the top of the image drum 
unit first, pushing it against the spring on the drum unit (a), then 
lower the right end of the cartridge onto the image drum unit (b).

     Toner_replace_F5_03.jpg  

a

b
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11. Pressing gently down on the cartridge to ensure that it is firmly 
seated, push the colored lever (1) towards the rear of the printer. 
This will lock the cartridge into place and release toner into the 
image drum unit.

      toner in positon_lock_Fig1_15.jpg  

12. Finally, close the top cover and press down firmly so that the 
cover latches closed.

     cover close_F5_22.jpg  

1
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Image drum replacement

    

Switch off the printer and allow the fuser to cool for about 
10 minutes before opening the cover.        

The printer contains four image drums: cyan, magenta, yellow 
and black.

1. Press the cover release and open the printer’s top cover fully.    

cover open button_F5_23.jpg 

2. Note the positions of the 4 cartridges.      I     

WARNING!

If the printer has been powered on, the fuser will be hot. 
This area is clearly labelled. Do not touch.

CAUTION!

Static sensitive devices, handle with care.     
Antistatic  symbol.jpg  

1. Cyan cartridge 2. Magenta cartridge

3. Yellow cartridge 4. Black cartridge

1

2

3

4
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3. Holding it by its top center, lift the image drum, complete with its 
toner cartridge, up and out of the printer.

        ID going out_Fig1_12.jpg  

4. Put the old unit down gently onto a piece of paper to prevent 
toner from marking your furniture.

5. Take the new image drum unit, complete with toner cartridge 
(assembled according to the installation guide) and place it on 
the piece of paper where the old ID unit was placed.

   

CAUTION!

The green image drum surface at the base of the cartridge 
is very delicate and light sensitive. Do not touch it and do 
not expose it to normal room light for more than 5 minutes. 
If the drum unit needs to be out of the printer for longer 
than this, please wrap the cartridge inside a black plastic 
bag to keep it away from light. Never expose the drum to 
direct sunlight or very bright room lighting.
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6. Remove the protective sheets from the image drum unit. Keep it 
the same way round as the old unit. Pack the old ID unit inside 
the packaging material for disposal.       Toner_remove paper 

7. Holding the complete assembly by its top center, lower it into 
place in the printer, locating the pegs at each end into their slots 
in the sides of the printer cavity.       ID_going in_Fig1_14.jpg  

8. Finally, close the top cover and press down firmly at both sides so 
that the cover latches closed.       

NOTE

If you need to return or transport your printer for any reason, 
please make sure you remove the image drum unit 
beforehand and place in the bag provided. This is to avoid 
toner spillage.
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Replacing the belt unit

The belt unit is located under the four image drums. This unit 
requires replacement approximately every 60,000 pages.

      

Switch off the printer and allow the fuser to cool for about 
10 minutes before opening the cover.

1. Press the cover release and open the printer’s top cover fully.

     cover open button_F5_23.jpg  

2. Note the positions of the 4 cartridges. It is essential that they go 
back in the same order.

     ID Positions_Fig1_04.jpg  

       

WARNING!

If the printer has been powered on, the fuser will be hot. 
This area is clearly labelled. Do not touch.

1. Cyan cartridge 2. Magenta cartridge

3. Yellow cartridge 4. Black cartridge

1

2

3

4
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3. Lift each of the image drum units (1), starting from the rear, out 
of the printer and place them in a safe place away from direct 
sources of heat and light (2).

      

   IDs _ all out_cover_F8_19.jpg  

CAUTION!

The green image drum surface at the base of each 
cartridge is very delicate and light sensitive. Do not 
touch it and do not expose it to normal room light for 
more than 5 minutes. If the drum unit needs to be out of 
the printer for longer than this, please wrap the 
cartridge inside a black plastic bag to keep it away from 
light. Never expose the drum to direct sunlight or very 
bright room lighting.

2

1
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4. Locate the two fasteners (1) at each side of the belt and the 
lifting bar (2) at the front end.

     unlock belt_F5_08.jpg  

5. Turn the two fasteners (1) 90° to the left. This will release the 
belt from the printer chassis.

6. Pull the lifting bar (2) upwards so that belt tilts up towards the 
front, and withdraw the belt unit from the printer.

    belt coming out_Fig1_33.jpg  

1

2

1
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7. Lower the new belt unit into place, with the lifting bar at the front 
and the drive gear towards the rear of the printer. Locate the 
drive gear into the gear inside the printer by the rear left corner 
of the unit, and lower the belt unit flat inside the printer. Turn the 
two fasteners (1) 90° to the right until they lock. This will secure 
the belt unit in place.

   belt_roll in _ F5_09.jpg   

ock_F5_09_1.jpg 
8. Replace the 4 image drums, complete with their toner cartridges, 

into the printer in the correct positions as shown.

      ID Positions_Fig1_04.jpg  

     

9. Finally, close the top cover and press down firmly at both sides so 
that the cover latches closed.

1. Cyan cartridge 2. Magenta cartridge

3. Yellow cartridge 4. Black cartridge

1

1

1

1

2

3

4
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Fuser replacement

The fuser is located inside the printer just behind the four 
image drum units.   

Switch off the printer and allow the fuser to cool for about 
10 minutes before opening the cover.

1. Press the cover release and open the printer’s top cover fully.   

cover open button_F5_23.jpg 

2. Identify the fuser handle (1) on the top of the fuser unit. Pull the 
two fuser retaining levers (2) towards the front of the printer so 
that they are fully upright.      fuser_out_F5_10.jpg  

WARNING!
If the printer has recently been powered on, some fuser 
components will be very hot. Handle the fuser with 
extreme care, holding it only by its handle, which will 
only be mildly warm to the touch. A warning label clearly 
indicates the area. If in doubt, switch the printer off and 
wait at least 10 minutes for the fuser to cool before 
opening the printer cover.

1

2

2
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3. Holding the fuser by its handle (1), lift the fuser straight up and 
out of the printer. If the fuser is still warm, place it on a flat 
surface which will not be damaged by heat.

4. Remove the new fuser from its packaging and remove the transit 
material.

5. Holding the new fuser by its handle, make sure that it is the 
correct way round. The retaining levers (2) should be fully 
upright, and the locating lugs (3) should be towards you. There is 
one locating lug at each end of the fuser.

     Fuser Alone.jpg  

6. Holding the fuser handle (2), lower the fuser into the printer, 
locating the two lugs into their slots in the metal partition which 
separates the fuser area from the image drums.     fuser going 

in_F8_12.jpg  

7. Push the two retaining levers (1) towards the rear of the printer 
to lock the fuser in place.

8. Finally, close the top cover and press down firmly at both sides so 
that the cover latches closed.

2
3

2
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Cleaning the LED head

Clean the LED head when printing does not come out clearly, has 
white lines or when text is blurred.

1. Switch off the printer and open the top cover.

2. Gently wipe the LED head surface with LED lens cleaner or soft 
tissue.

       Cleaning LED Head_F5_04.jpg  

     

3. Close the top cover.

CAUTION!

Do not use methyl alcohol or other solvents on the LED 
head as damage to the lens surface will occur.



Installing additional memory 

This section explains how to install additional RAM memory 
into your printer as a memory upgrade. 

Part Numbers

See “Part Numbers” on page 79.

Memory upgrade

The basic printer model comes equipped with 128 MB of main 
memory. This can be upgraded with an additional memory 
board containing 256 MB or 512 MB, giving a maximum total 
memory capacity of 640 MB.

Installation takes a few minutes, and requires a medium size 
cross-head (Philips type) screwdriver.

1. Switch the printer off and disconnect the AC power cable.

2. Press the cover release and open the printer’s top cover fully.

    cover open button_F5_23.jpg  

  

WARNING!
If the printer has been powered on recently, the fuser 
will be hot. This area is clearly labelled. Do not touch.
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3. Remove each image drum units, starting with the front. Cover 
the image drum units to protect them from direct light

    IDs _ all out_cover_F8_19.jpg  

4. Locate the two fasteners (1) at each side of the belt and the 
lifting bar (2) at the front end.

     unlock belt_F5_08.jpg  

2

1

1

2

1
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5. Unlock the fasteners and remove the belt as shown.

       belt coming out_Fig1_33.jpg   

6. Carefully remove the new memory board from its wrapping. Try 
to handle the board only by its short edges, avoiding contact with 
any metal parts as far as possible. In particular, avoid touching 
the edge connector.

7. Notice that the memory board has a small cutout in the edge 
connector, which is closer to one end than the other.

     Memory card_Fig1_30.jpg  
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8. Identify the RAM expansion slot  in the printer. Unclip the plastic 
cover to open this slot.

        Memory slot_Fig1_34.jpg  

9. If the RAM expansion slot already contains a memory upgrade 
board, that board will have to be removed before you can install 
the new one. To remove it proceed as follows, otherwise skip to 
step 10.

(a) Identify the locking clips at each end of the RAM expansion 
slot.

(b) Push the clips outward and back into the printer. The board 
will pop out slightly.

(c) Grip the board firmly by its short edges and pull it out of the 
slot.

(d) Place the removed memory board in the antistatic bag 
which originally contained the new memory board.

10. Hold the new memory board by its short edges, so that the edge 
connector faces in towards the RAM expansion slot, and the small 
cutout is closer to the bottom of the printer.
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11. Gently push the board into the RAM expansion slot until it latches 
in and will not go any further.

      Memory card In_Fig1_35.jpg   

12. Close the RAM expansion slot.

13. Replace the belt and image drum units.

See “Image drum replacement” on page 86.

See “Replacing the belt unit” on page 89.

14. Close the top cover of the printer.

15. Reconnect the AC power cable and switch the printer on.

16. When the printer is ready, print a menu map using the Print Menu 
option on the printer’s Information Menu.

17. Examine the first page of the menu map.

Near the top of the page, between the two horizontal lines, you 
will see the current printer configuration. This list contains the 
figure for total memory size.

This should indicate the total memory now installed, which should 
be the size of memory board you have installed plus 128 MB.
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Troubleshooting

Clearing paper jams

Provided that you follow the recommendations in this guide on use of 
print media, and you keep the media in good condition prior to use, 
your printer should give years of reliable service. However, paper 
jams occasionally do occur, and this section explains how to clear 
them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at any 
point on the paper path through the printer. When a jam occurs, the 
printer immediately stops, and the ATTENTION LED on the Operation 
Panel (together with the LCD display) informs you of the event. If 
printing multiple pages (or copies), do not assume that, having 
cleared an obvious sheet, others will not also be stopped somewhere 
along the path. These must also be removed in order to clear the jam 
fully and restore normal operation.

1. If a sheet is well advanced out of the top of the printer, simply 
grip it and pull gently to draw it fully out. If it does not remove 
easily, do not use excessive force. It can be removed from the 
rear later.
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2. Press the cover release and open the printer’s top cover fully.

     cover open button_F5_23.jpg   

        

3. Note the positions of the 4 cartridges.

        ID Positions_Fig1_04.jpg  

    

It will be necessary to remove the four image drums to gain 
access to the paper path.

WARNING!
If the printer has been powered on, the fuser will be hot. 
This area is clearly labelled. Do not touch.

1. Cyan cartridge 2. Magenta cartridge

3. Yellow cartridge 4. Black cartridge

1

2

3

4
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4. Holding it by its top center, lift the cyan image drum, complete 
with its toner cartridge (1), up and out of the printer.     ID goin

5. Put the cartridge down gently onto a piece of paper to prevent 
toner from marking your furniture and to avoid damaging the 
green drum surface.    

6. Repeat this removal procedure for each of the remaining image 
drum units. Cover the image drum units to protect them from 
direct light.       IDs _ all out_cover_2_F8_19.jpg  

CAUTION!

The green image drum surface at the base of the 
cartridge is very delicate and light sensitive. Do not 
touch it and do not expose it to normal room light for 
more than 5 minutes.

2

1
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7. Look into the printer to check whether any sheets of paper are 
visible on any part of the belt unit.

8. Remove any sheets of paper as follows: 

• To remove a sheet with its leading edge at the front of the 
belt, carefully lift the sheet from the belt and pull it forwards 
into the internal drum cavity and withdraw the sheet.       

    paper jam belt_F8_07.jpg  

• To remove a sheet from the central area of the belt, carefully 
separate the sheet from the belt surface and withdraw the 
sheet.

     Paper Jam fuser In_F8_08.jpg  

CAUTION!

Do not use any sharp or abrasive objects to separate 
sheets from the belt. This may damage the belt surface.
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• To remove a sheet just entering the fuser, separate the trailing 
edge of the sheet from the belt, push the fuser pressure 
release lever (1) towards the front and down to release the 
fuser’s grip on the sheet, and withdraw the sheet through the 
drum cavity area. Then allow the pressure release lever to rise 
again.    

9. Starting with the cyan image drum unit nearest the fuser, replace 
the four image drums into the drum cavity, making sure to locate 
them in the correct order.      ID Positions_Fig1_0  

NOTE

If the sheet is well advanced into the fuser (only a short 
length is still visible), do not attempt to pull it back. Follow the 
next step to remove it from the rear of the printer.

1. Cyan cartridge 2. Magenta cartridge

3. Yellow cartridge 4. Black cartridge

1

1

2

3

4
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• Holding the complete assembly by its top center, lower it into 
place in the printer, locating the pegs at each end into their 
slots in the sides of the printer cavity.

10. Lower the top cover but do not press down to latch it closed yet. 
This will protect the drums from excessive exposure to room 
lighting while you check the remaining areas for jammed sheets.

11. Open the rear stacker  and check for a sheet of paper in the rear 
path area.

     Paper Jam Back_F8_09.jpg  

• Pull out any sheets found in this area.

• If the sheet is low down in this area and difficult to remove, it 
is probably still gripped by the fuser. In this case raise the top 
cover, reach around and press down on the fuser pressure 
release lever (1).

      Paper Jam fuser release_F8_08.jpg  

12. If you are not using the rear stacker, close it once paper has been 
removed from this area.

1
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13. Press the front cover release and pull open the front cover.

     front cover open release_F7_04.jpg  

14. Check inside the cover for sheets in this area and remove any 
that you find, then close the cover.

        Paper Jam_front cover_F8_05_1.jpg  

2

1
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15. Pull out the Cassette Tray and ensure that all paper is stacked 
properly, is undamaged, and that the paper guides are properly 
positioned against the edges of the paper stack. When satisfied, 
replace the tray.

        Cassette Tray wPaper_Fig1_22.jpg  

16. Finally, close the top cover and press down firmly at both sides so 
that the cover latches closed.

   front cover close_F7_04_a.jpg  
When the jam has been cleared, if Jam Recovery is set to ON 
in the System Configuration Menu, the printer will attempt to 
reprint any pages lost due to paper jams.
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Error Messages

Error messages are displayed on the printer’s 2-line LCD. The 
bottom line shows the Error Code number. 

   
ERROR MESSAGES

ERROR 
CODE

LCD 2-LINE  
STATUS MESSAGE

EXPLANATION

none DOWNLOAD MESSAGE

FAILED <n>

Indicates that writing of message data 
to be uploaded has failed. The indicated 
code is a decimal value (one digit) and 
represents the cause of the failure:

1 = Unknown cause 
2 = Data Error; Hash check error in data 
reading/writing or abnormal FLASH 
3 = Overflow; Downloading failure due 
to FLASH memory full at starting or 
during writing 
4 = Memory Full; Memory reservation 
failure 
5 = Unsupported Data; Downloaded 
data unsupported on the printer

310 CLOSE COVER

310: COVER OPEN

The printer’s top cover is open.

311 CLOSE COVER

311: COVER OPEN

The printer’s front cover is open.

320 CHECK FUSER

320: FUSER MISSING

The fuser unit is not installed correctly.

330 CHECK BELT

330: BELT MISSING

The belt unit is not installed correctly.

340 
341 
342 
343

CHECK IMAGE DRUM

<nnn>:<a> DRUM 
MISSING

An image drum is not installed correctly:

340:Y = Yellow; 341:M = Magenta; 
342:C = Cyan; 343:K = Black

350 
351 
352 
353

REPLACE IMAGE 
DRUM

<nnn>:<a> DRUM 
MISSING

An image drum needs to be replaced:

350:Y = Yellow; 351:M = Magenta; 
352:C = Cyan; 353:K = Black

354 REPLACE FUSER

354: FUSER LIFE

Based on the counter, the fuser needs to 
be replaced. Printing will stop. 

355 REPLACE BELT

355: BELT LIFE

Based on the counter, the transfer belt 
needs to be replaced. Printing will stop. 
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356 REPLACE BELT

356: BELT LIFE

Indicates waste toner is full. Warning 
status takes effect only once: at Cover 
Open/Close; the error occurs again 
when about 500 copies have been 
printed.

380 OPEN FRONT COVER

380: PAPER JAM

A jam in the paper path (feed).

381 
382 
385 
389

OPEN TOP COVER

<nnn>: PAPER JAM

A jam in the paper path at the following 
location: 
  381: Transport 
  382: Exit 
  385: Around fuser unit 
  389: Printing page lost

390 CHECK MANUAL

390: PAPER JAM

A paper jam has occurred during paper 
feeding from the manual (MPT) tray.

391 OPEN FRONT COVER

391: PAPER JAM

A paper jam has occurred during paper 
feeding from the tray.

400 OPEN FRONT COVER

400: PAPER SIZE 
ERROR

An inappropriate size paper was fed 
from a tray. Check the paper in the tray 
or check for multiple feeds. Open and 
close the front cover.

410 
411 
412 
413

REPLACE TONER

<nnn>:<a> TONER 
EMPTY

A toner cartridge is empty:

410:Y = Yellow; 411:M = Magenta; 
412:C = Cyan; 413:K = Black

415 
416

REPLACE TONER

<nnn>:<a> WASTE 
TONER FULL

The indicated waste toner box is full and 
must be replaced:

415:M = Magenta; 416:C = Cyan

(Does not occur for Yellow or Black)
420 ADD MORE MEMORY

420: MEMORY 
OVERFLOW

Memory capacity has been exceeded 
due to one of the following:

- Too much print data in a page. 
- Too much Macro data. 
- Too much DLL data.

Press the ON LINE switch and decrease 
the amount of data sent to the printer or 
install expansion RAM.

461 LOAD <media size/
media type> AND 
PRESS ONLINE 
SWITCH

461: <tray> MEDIA 
MISMATCH

The media type in the tray and the print 
data do not match. Load the type of 
media specified in the print data and 
press the ON LINE switch.

ERROR MESSAGES

ERROR 
CODE

LCD 2-LINE  
STATUS MESSAGE

EXPLANATION
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491 LOAD <media-size>

491: <tray> EMPTY

The requested print tray is empty. Load 
paper.

540 
541 
542 
543

CHECK TONER 
CARTRIDGE

<nnn>:<a> TONER 
SENSOR ERROR

Something is wrong with a toner sensor:

540:Y = Yellow; 541:M = Magenta; 
542:C = Cyan; 543:K = Black

544 
545 
546 
547

CHECK TONER 
CARTRIDGE

<nnn>:<a> 
IMPROPER LOCK 
LEVER POSITION

A toner cartridge has not been locked:

544:Y = Yellow; 545:M = Magenta; 
546:C = Cyan; 547:K = Black

550 
551 
552 
553

GENUINE TONER IS 
RECOMMENDED

<nnn>:<a> NON 
GENUINE <color> 
TONER

The signature ID of a toner cartridge can 
not be recognized (i.e., toner is from an 
unauthorized third party):

550:Y = Yellow; 551:M = Magenta; 
552:C = Cyan; 553:K = Black

554 
555 
556 
557

REPLACE TONER 

<nnn>:<a> TONER 
REGIONAL MISMATCH

The signature ID of a toner cartridge is 
not correct for the distribution channel, 
but the group signature ID is correct 
(OKI regional mismatch):

554:Y = Yellow; 555:M = Magenta; 
556:C = Cyan; 557:K = Black

560 
561 
562 
563

REPLACE IMAGE 
DRUM

<nnn>:<a> DRUM 
LIFE

A “toner empty” error occurred after an 
image drum reached the end of its life:

560:Y = Yellow; 561:M = Magenta; 
562:C = Cyan; 563:K = Black

610 
611 
612 
613

INSTALL TONER 

<nnn>:<a> TONER 
MISSING

A toner cartridge is not installed:

610:Y = Yellow; 611:M = Magenta; 
612:C = Cyan; 613:K = Black

614 
615 
616 
617

REPLACE TONER 

<nnn>: 
INCOMPATIBLE <a> 
TONER 

The signature ID of a toner cartridge is 
not correct for the distribution channel 
(OEM mismatch):

614:Y = Yellow; 615:M = Magenta; 
616:C = Cyan; 617:K = Black

620 
621 
622 
623

REPLACE TONER

<nnn>: 
INCOMPATIBLE <a> 
TONER

The signature ID of a toner cartridge is 
not correct for the distribution channel 
(OEM mismatch):

620:Y = Yellow; 621:M = Magenta; 
622:C = Cyan; 623:K = Black

various SERVICE CALL

<nnn>: FATAL ERROR

A fatal error occurred. The number 
specifies the cause of the error. Fatal 
errors require a Service Call.

ERROR MESSAGES

ERROR 
CODE

LCD 2-LINE  
STATUS MESSAGE

EXPLANATION
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Specifications

   
ITEM SPECIFICATION

Dimensions 14.8 x 18.86'' x 11.42'' (W x D x H)

376 x 479 x 290mm (W x D x H)
Weight 46.3 lbs. (21 Kg)  approximately
Print speeds 16 pages per minute color

20 pages per minute monochrome
Resolution 600 x 600 dpi 

1200 x 600 dpi

600 x 600 dpi x 2 bit
Emulations Windows GDI, Direct Raster, PostScript3, PCL 5C, HP-

GL, PCL XL, PCL 6e, Epson FX, IBM ProPrinter III XL
Auto Features Auto registration 

Auto density adjustment 
Auto consumable counter reset

Memory 128 MB standard (upgradable to 256 MB or 512 MB)
Operating 
Platform

Windows, Macintosh

Paper capacity

   20 lb. 
   80 g/m²

250 sheets in the Cassette Tray

1 sheet in Multi Purpose Tray

Paper weight Standard Printing

   Cassette Tray

      17 ~ 32 lb.

      64 ~ 120 g/m² 

   Multi Purpose Tray

      20 ~ 54 lb.

      75 ~ 203 g/m² 

2 Sided (Manual Duplex) Printing

   Cassette Tray

      17 ~ 28 lb.

      64 ~ 120 g/m² 

Multi Purpose Tray

      20 lb. ~ 28 lb. 

      75 ~ 105 g/m²
Paper output

   20 lb.

   80 g/m²

Face down (top) stacker:  150 sheets   
                                    (64 – 120 g/m²)

Face up (rear) stacker:  1 sheet  
                                    (64 – 203 g/m²)

Printer life 300,000 pages or 5 years
Duty cycle 35,000 pages per month maximum or 5,000 average
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Toner life Standard cartridge (at 5% coverage) 
C, M, Y: approximately 2,000 pages   
B: approximately 2,500 pages   

Image drum 
life

15,000 pages at 3 pages per job

Belt life 50,000 letter-size pages
Fuser life 50,000 letter-size pages

ITEM SPECIFICATION
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Utilities

Overview ________________________
The following utilities are available for your printer.

Color Correction Utility  

Color Swatch Utility  

Direct Network Printing Utility (LPR)  

Network Print Status Utility 

Network Setup Utility  

Print Job Accounting Utility

Operator Panel Language Set-up Utility

PrintSuperVision

Web Driver Installer

Accessing ________________________
You can access the utilities two ways:

via the CD shipped with the printer

via a download from the internet, accessed through the 
Menu Installer on the CD

Here is a list of the utilities provided on the CD shipped with your 
printer.

Color Correction Utility  

Color Swatch Utility  

Direct Network Printing Utility (LPR)  

Network Print Status Utility 

Network Setup Utility  

Operator Panel Language Set-up Utility

Here is a list of the utilities provided via download.

Print Job Accounting Utility

PrintSuperVision

Web Driver Installer



Description of Utilities ______________
1. Color Correction Utility

This utility allows you to fine tune the printer’s color 
settings and save them for future use. 

"Color Correction Utility" on page 118.

2. Color Swatch Utility

This utility allows you to print color samples or swatches 
on your color printer. The swatches are used with your 
software program to select and reproduce color 
accurately. The swatches represent selected samples of 
the your printer's color palette and can be used to find the 
desired colors for your printed documents.

"Color Swatch Utility" on page 131.

3. Direct Network Printing Utility (LPR)

The Direct Network Printing Utility (LPR) allows you to 
print directly to a printer on the network without a print 
server. It creates a Printer Port, and installs a pop-up 
status box so you can monitor printer status. 

The Direct Network Printing Utility (LPR) operates in 
Windows Me/98, Windows NT 4.0, Windows 2000, and 
Windows XP operating systems.

"Direct Network Printing Utility (LPR)" on page 135.

4. Network Print Status Utility 

This utility allows you to view (but not change) the status 
of the following on the Status tab:

• paper trays installed and the media assigned to 
them.

• total size and percentage used of disk/memory.

• percentage of toner remaining.

"Network Printer Status Utility" on page 137. 

5. Network Setup Utility

This utility provides an easy way to configure your printer 
on a network. 

See the online Network User’s Guide for details on how to 
use this utility. "Network Setup Utility" on page 141.
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6. Print Job Accounting Utility

The Print Job Accounting software, designed specifically 
for OKI printers in a network environment, provides job 
accounting features that allow you to track printer usage, 
calculate printing costs, and specify access available to 
each client (user).                   

7. Operator Panel Language Set-up Utility

The Operator Panel Language Setup utility changes the 
language on the printer's LCD display panel. The utility is 
on the CD-ROM that comes with your printer. For more 
information about the utilities, see "Overview" on 
page 114. 

Follow the steps in the setup utility to select the 3600n 
printer and the desired language. To complete the 
language setup, re-start your printer (i.e., turn it off and 
then on).

8. PrintSuperVision

PrintSuperVision is a web-based application for managing 
printing devices connected to a network. PrintSuperVision 
provides access to networked printer data for monitoring, 
reporting and managing networked printers. It provides a 
full range of management functions for OKI printers, and 
for other brands of printers as well.

9. Web Driver Installer

This utility is a web-based application. It automates tasks 
for a network administrator.

• Discovering printers connected to a TCP/IP network

• Displaying discovered printers on a web page

• Sending users e-mail notification of the URL that 
permits the downloading of printer driver installation 
programs for discovered printers. 

Administrators can use this utility to manage printers and 
users organized in groups, such as departments or floors.
C3600n User’s Guide
116



C3600n User’s Guide
117

Installing the Utilities_______________

Windows

Utilities on the CD
Load the utilities from the Menu Installer located on the 
CD supplied with your printer.

Download Utilities
Download the utilities from the internet, accessed through 
the Menu Installer on the CD.

Macintosh OS 9.x

Utilities on the CD
1. Insert the CD supplied with your printer into the CD-ROM drive.

2. Double-click the CD icon that appears on the desktop.

3. Open the MAC folder.

4. Click PSDRV → English.  Double click the Mac Installer icon.

5. Click Continue.  Accept the Software License Agreement.

6. Select Custom Install to access the Utility Installation.

7. Click the boxes beside the Utilities you wish to install.  Click 
Install.

The Utilities install into the folder you specify during the 
installation process.

Download Utilities
Download the utilities from the internet, accessed through 
the Menu Installer on the CD.

Macintosh OS 10.1, 10.2, and 10.3

Utilities on the CD
The utilities on the CD are not available for Mac OS X and will only run 
on Mac 9.x or Classic OS.

Once the Print Job Accounting utility has been set up by your Network 
Administrator, it is transparent to the operation of the printer driver 
on your OS X system. 

Download Utilities
Download the utilities from the internet, accessed through 
the Menu Installer on the CD.



Color Correction Utility ______________

General Information
This utility allows you to fine tune the printer’s color settings and save 
them for future use. 

The Color Correct Utility is the best choice for working with Microsoft 
Excel or Word. 

You can use the Color Correct Utility to:

• Change the Pallete Color:  see page 119

• Adjust the Gamma Value and Hue:  see page 127

How to Install
Load this program from the Menu Installer located on the CD. 

Additional Information
For more information, see the on-line help in the utility.
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Change the Pallete Color

General Information
      

There are four steps in changing the Pallete Color.

1. Print the Sample Color Chart.

See page 120.

2. Print the Color Adjustment Chart.

See page 121.

3. Make the adjustments.  Save the adjustments, using a name you 
select.

See page 123.

4. When printing a document, select the name of the saved 
adjustment settings.

See page 126.

NOTES
This feature is not available for Windows Me/98.

This feature is not available for shared printers.

When test printing, use paper larger than B5 size.
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Change the Pallete Color

Step 1:  Print the Sample Color Chart
1. Click Start → Programs → All Applications.

Windows XP

Click Start → Programs → Okidata → Color Correct 
Utility → Color Adjustment Utility.

2. Select Adjust Pallete Color. Click Next.

3. The Select Printer screen appears. Select the printer you are 
using.  Click Next.

The Color Correct Utility starts.

Installed printer drivers display. You must setup each 
driver.

4. The Select Setting screen appears. From the list, select the 
desired setting. Click Sample Print.

5. The Sample Color Chart prints.
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Change the Pallete Color

Step 2:  Print the Color Adjustment Chart
First, you must perform the steps in “Step 1: Print the Sample Color 
Chart” see page 120.

6. Click Next.

7. The Pallete Color Matching screen appears.

      cadjust1.jpg               
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8. Click Test print.

The Color Adjustment Chart prints.
     Fig5-17.jpg          

9. Compare the printed Color Adjustment Chart to the Pallete Color 
Matching screen.

If the printed colors do not match the screen, perform an 
adjustment.

You cannot adjust colors marked with an X.
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Change the Pallete Color

Step 3:  Make the adjustments and save the 
settings

First, you must perform the steps in “Step 1: Print the 
Sample Color Chart” see page 120 and “Step 2: Print the 
Color Adjustment Chart” see page 121.

When making the adjustments, you are obtaining the best 
possible match between the values for Hue and 
Brightness on your Sample Color Chart and the Pallete 
Color Matching screen.

10. On the Pallete Color Matching screen, click the color you want to 
adjust.

      cadjust1.jpg               
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11. The Enter Adjustment Value screen appears.

View the pull down menus for the Hue (X) and Brightness 
(Y) values.  

You are finding the available ranges for both Hue (X) and 
Brightness (Y).

The available ranges (values) vary according to color.

12. Use the Sample Color Chart.

Find the color you want to adjust. 

Locate the desired color within the identified available 
ranges (values) from Step 10.

Find the values for both Hue (X) and Brightness (Y)

13. On the Pallete Color Matching screen, click the color you want to 
adjust.

The Enter Adjustment Value screen appears.

View the pull down menus for the Hue (X) and Brightness 
(Y) values.

Adjust the values for Hue and Brightness to match the 
values from Step 11.

      cadjust1.jpg               
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14. Click OK.

15. The Pallete Color Matching screen appears.

      cadjust1.jpg               

16. Click Test Print.

The Color Adjustment Chart prints.
     Fig5-17.jpg          

17. Compare the printed Color Adjustment Chart to the Pallete Color 
Matching screen.

If you are satisfied with the comparison, go to step 17.

If you are not satisfied, repeat steps 10 through 16.

18. If you have another color you want to adjust, repeat 10 through 
16.

19. When you have finished adjusting all desired colors, click Next.

20. Enter the setting name. Remember the name for future use.

21. Click Save.

22. Click OK.
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Change the Pallete Color

Step 4:  Use the saved settings to print a 
document

Windows

1. Open the file you want to print.

2. Click File → Print.

3. In the Print dialog box, select your printer.

4. Next: 

Windows XP:  Click Properties. Click Advanced.

Windows 2000:  go to the next step.

5. On the Color tab, under Color Mode, under User Setting, select 
the Color Matching name you created using the Color Correct 
Utility

6. Click OK.

7. Print the document.
C3600n User’s Guide
126



Adjust the Gamma Value and Hue

General Information

1. Click Start → Programs → All Applications.

2. Your action depends on your operating system.

Windows XP:  Click Okidata → Color Correct 
Utility → All Applications.

Windows 2000:  Go to the next step.

3. Select Correct gamma and hue.  

4. Click Next.

5. The “Select printer” screen appears.  Select the printer you want 
to adjust.

6. Click Next.

7. The Color Correct Utility starts.

The installed printer drivers display.

You must setup the Color Correct Utility for each driver.

8. In the list box, select the mode.

9. Click Next.

NOTES
This feature is not available for Windows Me/98.

This feature is not available for shared printers.

When test printing, use paper larger than B5 size.

You must have Administrator authority when setting up a 
network connection in Windows XP/2000/NT4.0/Server 2003.
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10. Change the slide bar values of gamma, hue, brightness, and 
saturation to adjust the color.

Use primary colors of ink

Select this to adjusts the settings to the standard hues 
for the printer.

         

The Gamma slide bar adjusts total brightness.

The Hue/Brightness slide bar adjusts output color.

Use the printer color buttons to switch to a different color.

Brightness

For Brighter color, slide the Gamma bar to the left.

Hue

Adjustments are made relative to positions on the color 
wheel.

Move forward = + (counter-clockwise)

Move backward = - (clockwise)

Hue Toner printing

R (Red) 50% yellow and 50% 
magenta

Y (Yellow) 100% yellow
G (Green) 50% cyan and 50% yellow
C (Cyan) 100% cyan
B (Blue) 50% magenta and 50% 

cyan
M (Magenta) 100% magenta
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Example: adjust the Y (yellow) slide bar:

Move forward = + (counter-clockwise), the color 
becomes more green.

Move backward = - (clockwise), the color becomes 
more red.

       F5_03_300.jpg          

11. Click Test Print.

12. The Adjustment Confirmation Sample prints.

13. If the sample meets your requirements, click Set.

If the sample does not meet your requirements, repeat 
Steps 10 – 12 until your requirements are met. Then, click 
Set.

14. Click Save.

15. Enter the setting name.

16. Click OK.

17. Click OK.

           

18. Click Complete to exit the Color Correct Utility.

19. When printing a document, select the setting name.

NOTE
When you update or reinstall a printer driver, the Color 
Correct Utility reloads the created Color Matching names. 
Make sure that the Color Matching names appear in the 
[Setting Selection].  Click Complete.
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Adjusting the Gamma Value and Hue

Use the saved settings to print a document
Windows

1. Open the file you want to print.

2. Click File → Print.

3. In the Print dialog box, select your printer.

4. Next: 

Windows XP:  Click Properties. Click Advanced.

Windows 2000:  Go to the next step.

5. On the Color tab, under Color Mode, under User Setting, select 
the Color Matching name you created using the Color Correct 
Utility.

           

6. Click OK.

7. Print the document.

NOTE
When you update or reinstall a printer driver, the Color 
Correct Utility reloads the created Color Matching names. 
Make sure that the Color Matching names appear in the 
[Setting Selection].  Click End.
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Color Swatch Utility ________________

General Information
The Color Swatch Utility allows you to 

• print color samples (swatches) on your color printer.               

• create custom color swatches           

The swatches are used with your software program to select and 
reproduce color accurately. 

The swatches represent selected samples of the printer's color 
palette. Use the swatches to find the desired colors for your printed 
documents.

  

NOTE
• The Swatch Utility does not guarantee that the 

printer prints the same color as displayed on your 
monitor. Consider the displayed color as a 
reference.

• The printer may not be able to print the exact color 
that you desire.

• Your software may not be able to match colors 
using the swatch information. You may need to use 
other matching methods.

• The color swatch samples do not show all the 
colors your printer can print.

• Other factors influence how you see color: the 
color and finish of the paper, ambient light, even 
the color surrounding the one you are looking at.
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How to Install
Load this program from the Menu Installer located on the CD.

Additional Information
For additional information, see the Swatch Utility Read-me file located 
in the Windows Programs list.       

Printing Color Swatches
 

1. Install the utility from the CD using the Menu Installer 
(Windows). 

2. Click Start → Programs → Color Swatch → Color Swatch 
Utility.

3. A swatch page displays, showing commonly used colors.

4. Select print to print sample pages.

NOTE
• The color swatch samples do not show all the 

colors your printer can print.
• The Swatch Utility does not guarantee that the 

printer prints the same color as displayed on your 
monitor. Consider the displayed color as a 
reference.

• The printer may not be able to print the exact color 
that you desire.
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 color_swatch_samples.jpg  

5. Use the color blocks to pick the specific colors that you want to 
appear in your printed document. 

Each color block, or sample, is identified with information 
your software package needs to reproduce that color 
accurately. 

The numbers under each block specify the amounts of the 
primary colors—red (R), green (G), and blue (B)—that 
mix to form each particular shade. 

The amounts are given as a numerical value between 0 
and 255.
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Creating Custom Swatch Colors
 

If you don't find your desired color, you can create or customize 
colors:

1. Select Custom Swatch from the File menu. 

2. On the pop-up window, there are 3 slide bars that allow you to 
customize swatches:

• Hue bar changes the hue of the swatches, for example, red to 
green or blue to yellow.                 

• Saturation bar changes vividness.                                

• Lightness bar changes darkness.                                     

3. Adjust the bars until you see the desired color. 

Color variations are created to help you find the best 
match.

4. Click OK. 

5. Print the custom swatch page. 

6. Repeat these steps until you find the desired printed color.

7. For additional information, see the Swatch Utility Read-me file 
located in the Windows Programs list. 

The file includes:

• Applying Color Value in your Application  

• Setting Monitor Color  

NOTE
The Swatch Utility does not guarantee that the printer prints 
the same color as displayed on your monitor. Consider the 
displayed color as a reference.

The printer may not be able to print the exact color that you 
desire.
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Direct Network Printing Utility (LPR) ___

General Information
The Direct Network Printing Utility (LPR) allows you to print directly 
to a printer on the network without a print server. It creates a Printer 
Port, and installs a pop-up status box so you can monitor printer 
status. 

The Direct Network Printing Utility (LPR) operates in Windows Me/98, 
Windows NT 4.0, Windows 2000, and Windows XP operating systems.

Load this program from the Menu Installer located the CD.

How to Install
The Direct Network Printing Utility (LPR) supports TCP/IP. Your 
network administrator will first need to set up an IP address and TCP/
IP properties for your printer.

Your network administrator may have already installed this software. 
If you need to install it manually, load it from the Menu Installer on 
the CD:

1. Place the CD supplied with your printer in your CD-ROM drive.  
Wait for the Menu Installer to open.

If the CD does not AutoPlay, click 
Start → Run → Browse. Browse to your CD-ROM.  
Double-click Install.exe. Click OK.

2. Click Next to accept the terms in the license agreement.

3. Click Optional Utilities → Install Direct Network Printing Utility.  
Follow the on-screen instructions.

Direct Network Printing Utility (LPR) Status Box
   LPR_status_no_Oki.jpg  

The Direct Network Printing Utility (LPR) Status Box displays the 
following information: 

• Printers

Names of added printers (You can add up to 30 printers)

• Status
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Direct Network Printing Utility (LPR) status (empty, 
connecting, sending, paused, checking status, not 
connected)

• Finish

Number of completed jobs.

• Queue

Number of jobs waiting to be printed. 

Additional Information
For help, click on HELP in the program. 
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Network Printer Status Utility 

Windows
• Available on TCP/IP network connection only.

The Network Printer Status utility is available if your administrator has 
installed it. 

If the utility is installed, the printer driver Properties dialog box 
changes.

• a new Status tab is added.

• an Option button is added to the Device Option tab.

This utility allows you to view (but not change) the status of the 
following on the Status tab:

• paper trays installed and the media assigned to them.

• total size and percentage used of disk/memory.

• percentage of toner remaining.
 

Important!
If you select Automatic Status Update in the 
Status tab, the driver automatically pings the printer 
for the latest status information every time you open 
the Properties dialog box. 
This causes a significant delay until the Properties 
dialog box opens. 
To avoid this, use the Update Status button in the 
Status tab to manually update the information on 
demand. 
C3600n User’s Guide
137



General Information
This utility creates an additional tab (STATUS) in the PostScript and 
PCL drivers that allows the client to monitor the selected printer’s 
status.

Load this program from the Menu Installer located on CD1.

Installation
1. Insert the Drivers, Color, and Network Utilities disk into the 

CD-ROM drive.

If CD does not AutoPlay, click Start → Run → Browse. 
Browse to your CD-ROM. Double-click Install.exe. Click 
OK.

2. Click Network Software → Administration Tools → Network 
Printer Status. Follow the on-screen instructions. 
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Using
1. Click Start → Settings → Printers. Right-click the Sharp 

Printer icon. Click Properties. 

2. Click on the STATUS tab.

3. Click the UPDATE button to see device settings. 

The following screen displays: NetStatus2K.jpg 

Click on an item to see this information:      

Trays: Paper Type, weight

Duplex: Installed/not installed

Disk/Memory: RAM size and % used;
Flash Memory size and % used

Toner Remaining: % toner remaining in all cartridges

NOTE
If the Automatic Status Check box is checked, this utility 
“pings” the printer every time you open the Printer Properties 
dialog in the printer driver. 

This severely slows opening Printer Properties.
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Checking the Printer Status
Click the WEB SETTING button. The following screen displays:

  NetStatusK.jpg  

Click on the items listed on the left to see:

• Network Summary

• Login for Administrators

• Job Login

• Printer Menu

To see real-time printer status, click the UPDATE STATUS button.
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Network Setup Utility _______________

General Information
This utility provides an easy way to configure your printer on a 
network. 

How to Install
Load this program from the Menu Installer located on the CD. 

Additional Information
See the online Network User’s Guide for details on how to use this 
utility. The Network User’s Guide is found on the CD shipped with your 
printer.
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